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Patents and Trademarks

ProteinSimple's Simple Plex technology is covered by issued and pending patents in the U.S. and other
countries. For more information please see http:.//www.proteinsimple.com/Intellectual_Property.html.

ProteinSimple, the ProteinSimple logo, Simple Plex and Ella are trademarks or registered trademarks of Pro-
teinSimple. Other marks appearing in these materials are marks of their respective owners.

Intellectual Property Notices

This manual is covered by U.S. and international copyright laws. No part of this manual may be reproduced,
modified or transmitted in whole or in part in any form or by any means, electronic or mechanical, including
photocopy, recording, or any information storage and retrieval system, without permission in writing from
ProteinSimple. ProteinSimple hereby grants permission to its customers who have purchased Ella to make
limited numbers of photocopies or electronic copies of this manual without modifications as they may
require for their own use if such use is restricted to the purpose of installing or operating Ella.

Simple Plex software is subject to the licenses set forth in ProteinSimple’s standard Terms and Conditions.

Ella Disclaimer of Warranty

EXCEPT AS EXPRESSLY PROVIDED IN ANY PROTEINSIMPLE SOFTWARE LICENSE AGREEMENT OR QUOTATION,
THE PRODUCTS SOLD AND SERVICES PROVIDED BY PROTEINSIMPLE ARE PROVIDED ON AN “AS IS" AND "AS
AVAILABLE" BASIS WITHOUT WARRANTY OF ANY KIND. PROTEINSIMPLE AND ITS SUPPLIERS DO NOT WAR-
RANT THE SECURITY, PRIVACY, OR ACCURACY OF ANY DATA PROVIDED VIA THE PRODUCTS OR SERVICES,
AND YOU AGREE THAT THE USE OF ANY SUCH DATA BY YOU IS AT YOUR SOLE RISK. TO THE MAXIMUM
EXTENT ALLOWED UNDER APPLICABLE LAW, PROTEINSIMPLE AND ITS SUPPLIERS DISCLAIM ANY AND ALL
WARRANTIES, WHETHER EXPRESSED, IMPLIED OR STATUTORY, INCLUDING, WITHOUT LIMITATION, ANY WAR-
RANTY OF MERCHANTABILITY, TITLE, NON-INFRINGEMENT, OR FITNESS FOR A PARTICULAR PURPOSE.
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ProteinSimple Contact Information

ProteinSimple

3001 Orchard Parkway
San Jose, CA 95134
Toll-free: (888) 607-9692

Tel: (408) 510-5500
Fax: (408) 510-5599

email: techsupport@bio-techne.com
web: www.proteinsimple.com

Scope

For the proper operation of the system and/or all parts thereof, the instructions in this manual must be
strictly and explicitly followed by experienced personnel. All of the contents of this guide must be fully read
and understood prior to operating the system or any parts thereof.

FAILURE TO COMPLETELY READ AND FULLY UNDERSTAND AND FOLLOW ALL OF THE CONTENTS OF THIS
GUIDE PRIOR TO OPERATING THE SYSTEM OR PARTS THEREOF MAY RESULT IN DAMAGE TO THE EQUIPMENT
OR PARTS THEREOF AND INJURY TO ANY PERSON OPERATING THE SAME.
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Revision History

Revision Date Description of Change

Rev 1 June 20,2014 Initial Release per DCR-14-0004.
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DCR-15-0005.

Rev D September 21,2015 | Simple Plex software v2.2 release updates, ECO-15-0015.

Rev E February 25,2016 Simple Plex software v3.0 release and new cartridge updates,
DCR-16-0016.

Rev F September 16, 2016 Internal Distribution Only. Not released in product.

Rev G September 22,2016 | Simple Plex software v3.2 release and data export capability to

Watson LIMS, removed shipping block, DCR-16-0084. Docu-
ment number is D40-1000-001.

Rev H July 18,2017 Safety and certification, Simple Plex software v3.3 release, and
new 32x4 cartridge updates, DCR-17-0028.

Rev J September 14, 2017 Updates to Declaration of Conformity.

Rev K June 8,2018 Ella with laptop product introduction updates, ECO-000548.
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User Guide for Ella



Table of Contents

Patents and Trademarks. ............................. fi
Intellectual Property Notices .......................... it
Ella Disclaimer of Warranty........................... fi
ProteinSimple Contact Information .................. fii
SCOPE. fii
Revision HIStOry..........oooo i v

Chapter 1:

overview...............ooiiiiiiiiii 1
Function/Intended Use ....................cociii.n. 2
SPECfications. ..o 2
Acquiring Data ................c. 4
Viewing Ella System Information ..................... 4
Cautions and Warnings .............................. 5
General Safety Precautions ...................... 5
Electrical Safety Precautions ..................... 5
CautionMarkings........................coo.. 7
MovingElla...............oo i 8
Interconnections: Ella to Computer................... 8
Ella System Interconnections. .................... 9
EllawithlLaptop ................................ 14
Contacting Customer Service. ....................... 16
CUSTOMEr ServICe. ... 16
Technical Support .............................. 16

User Guide for Ella

page v

Chapter 2:
Getting Started............................. 17
INErodUCtion ... 18
Ella System Components ..............cccoevveeii.., 18
Ella... .o 18
Simple Plex Cartridges and Assays .............. 19
BarCode Scanner.......................oo. 22
PC and Simple Plex Software.................... 22
Verification Cartridge ........................... 23
Starting and Shutting Down Ella .................... 23
Starting the System ............................. 23
PoweringUpElla................................ 25
Powering Up Ella’s Computer ................... 25
Starting the Simple Plex Runner Program ... ........ 25
Shutting Down the System...................... 25
Chapter 3:
Running Cartridges........................ 27
INErodUCtion ... 28
Barcode Labels. ..., 29
KitLabel. ... 29
Cartridge Label.................................. 29
Prepare Samples and Reagents...................... 30

Plasma (EDTA or Heparin) and Serum Samples .30
Other SpecimenTypes ...............cccovui... 31

CUSTOM ASSAYS . . 31



Prepare Cartridge. ...........................oiiii. 31
Procedure............ccoiiiiiiii 31
Configure and Run with Simple Plex Runner ......... 38
Introduction .................c o 38
Starting the Simple Plex Runner Program ... .. 39
Configuring YourRun. .......................... 40
Observing Run Progress......................... 46
Viewing and Exporting Kit Results............... 48
Simple Plex Runner Settings..................... 49
The Data Repositories. ..............ccoeveiiiiii .. 53
Recoveringa CYDAT ... 53
Browsing/Retrieving the Self-Tests .............. 53
Chapter 4:
AnalyzingData............................. 54
INEroduction ... 55
Starting the Simple Plex Explorer Program............ 56
GUIFeatures. ... 56
KitResults Tab. ..o, 57
GNRFiltering. ..., 58
ResultsWarning ......................ccooo... 59
NoGNRsFound................coociiiiii . 60
CurveTab........cooiiiiii 61
Builda Curve Screen ......................o.. .. 62
ExportKits Screen .................cccciiiien... 63
Apply Curves to Kits Screen...................... 68
Activating your Simple Plex Explorer Installation. . . .. 70
Chapter 5:
MaintainingElla............................ 72
INEroduCtion ... 73
Using the Simple Plex Runner Tools Menu ........... 73

User Guide for Ella

page vi

Ella Self-Test. ......ccovuiiiii i 73
Using the Move To Commands in the Simple Plex
Runner Software Menu.......................... 80
Preparing Ella for Shipment.......................... 81
Exporting System Logs ..., 81
Maintenance and Cleaning.......................... 81
Fan Filter Cleaning and Maintenance........... 81
External Surface Cleaning....................... 82

Cartridge Nest and Objective Window Cleaning 82

Chapter 6:
Simple Plex 21 CFR Part 11 Compliance. 83
OVEIVIEW. . .. e 84

Activating 21 CFR Part 11 Support for Simple Plex

RUNNEr. ... o 84
Enabling 21 CFR Part 11 Mode for Simple Plex

RUNNET. . 86
Administering User Groups .......................... 86
Logging In, Logging Out and Locking ............... 88
Saving Changes ..., 93
Viewing Change History ............................. 94
Appendix A:

EC Declaration of Conformity ............ 96
Appendix B:

Managing Users and Groups for 21 CFR
Part 11 Support............................ 98
Managing Users and Groups ........................ 99
Appendix C:

Watson LIMS Interface Guide............ 104
OVEIVIEW. . ..o 105

Tips for Configuring Watson LIMS Master Assay ... 105



Sample Entry Requirements for Watson LIMS. ... .. 105
Details foreach Sample Type .................. 105

Generate Sequence Files in Watson LIMS using Generic
Raw DataInterface................................. 106

Importing Watson LIMS Sequence Files into Simple Plex

SORWAre. ... 108
Exporting Run Data into Watson LIMS Sequence Files
from Simple Plex Software.......................... 110
Appendix D:

Generic LIMS Interface Guide ........... 114
OVEIVIEW .. 115
Steps from Simple Plex Runner...................... 115
Steps from Simple Plex Explorer..................... 119

Supported Columns List and File Specifications. . ... 121
Additional Specifications ...................... 122

Custom Column Import and Export Example Files..123

User Guide for Ella

page vii



page 1

Chapter 1:

Overview

Chapter Overview

Function/Intended Use
Specifications

Acquiring Data

Viewing Ella System Information
Cautions and Warnings

Moving Ella

Interconnections: Ella to Computer

Contacting Customer Service

User Guide for Ella



Function/Intended Use page 2

Function/Intended Use

Ella™ is a fully automated cartridge-based system that enables researchers to measure biomarkers in multi-
ple sample types. Ella, together with microfluidic technology (Simple Plex™ cartridges), allow for single ana-
lyte measurements, the measurement of multiple analytes in parallel (multi-analyte), and also multiplexed
measurements. Researchers can also configure Simple Plex cartridges to be unigue to their own research.

Using Ella you can:

-+ Automatically execute an immunoassay protocol

- Automatically acquire and process data

- View and analyze fluorescence and concentration data on a per analyte, per sample basis

- Extract and save fluorescence and concentration information for application-specific analysis

Specifications

This section describes Ella's specifications, including environmental conditions, electrical ratings, physical
conditions, laser classification, and external fusing. See Table 1-1.
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Description

Specification
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Environmental Conditions

For Indoor Use Only

Altitude up to 2000 m (6600 ft)

Temperature Range: 15° to 30° C (59° to 86° F)
Humidity: 15 to 80% RH, non-condensing
Rated Pollution Degree: Degree 2

Electrical Ratings

100-240 V(AC), 300 VA, 45/65 Hz, Class |
Installation Category (Over Voltage) Il

NOTE: Electrical values listed are nominal.

Electrical Test Specifications

CB Scheme:
IEC61010-1:2010
Supplemented by IEC 60825-1:2014

TOV SUD “CUE” Scheme:
CAN/CSA-C22.2 No.61010-1:2012
UL61010-1:2012
EN61010-1:2010

EN 60825-1:2014

Physical Conditions

Overall dimensions:
37 cm (W) x 54 cm (d) x 26 cm (h)
14.6in (w)x21.3in(d)x10.2in (h)

Weight: 16 kg (35.3 Ib)

Laser Test Specifications

Class 1 Laser Product according to IEC 60825-1:2014
and EN 60825-1:2014

Complies with FDA performance standards for laser
products 21 CFR 1040.10 and 1040.11 except for devia-
tions pursuant to Laser Notice No. 50, dated June 24,
2007.

External Fusing

Main fuse (appliance inlet): 4 A, 250 V; IEC 60127 rated
as T4AL 250V

Table 1-1: Specifications
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Acquiring Data

The steps involved in acquiring data using Ella are:

1. Initializing Ella

2. Loading a Simple Plex cartridge containing samples and buffer

3. Setting up and starting a run

Viewing Ella System Information

In the Simple Plex Runner software interface, you can view current information about Ella including:
+ Serial number and firmware version

«  Software version information

«  ProteinSimple contact information

To view Ella’s system information, from the Simple Plex Runner software interface:

1. Click Help > About. The About screen will appear as shown in Figure 1-1.

About *

Simple Plex Runner Version: | 3.3.0.70 |

plgelEllplsimple

& bistechs i

Analyzer Firmware Version: | 1.0.0 |

pmteir@

E—

Analyzer Serial Number: | Ella-14120033 |

21 CFR Part 11 Support
Activated Analyzer Description: |  Biology LabUnit2 |

ProteinSimple 3001 Orchard Parkway San Jose, California, 95134 USA

Toll-Free: (844) 297-5391 Website: proteinsimple.com

Figure 1-1: Simple Plex Runner About screen.
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Cautions and Warnings

The following sections describe the safety precautions you should observe when using Ella. These include
precautions for:

General safety
Electrical safety

Laser light safety

General Safety Precautions

CAUTION
A Ella’'s operator should be trained by qualified personnel on the correct operation of the
instrument, and be aware of the safety issues involved.

Lopérateur d'Ella doit étre formé par un personnel sachant bien faire fonctionner I'instru-
ment, et doit étre au courant des problemes de sécurité qui sont impliqués.

Electrical Safety Precautions

This section describes the electrical safety precautions for Ella’s electrical connections and fuse, as well as
high voltage hazards.

Electrical Connections

Plug Ella into a grounded circuit capable of delivering at least:
15 amps for a 100-volt to 120-volt power source
12 amps for a 200-volt to 240-volt power source

See the rating label on Ella for more information.

Fuse

The primary input fuse holder is on the right side of the back of Ella and contains one 4A, 250V slo-blow fuse.
The fuse holder is designed to accept a 5 mm x 20 mm fuse. Replacement fuse specification should meet
the [EC 60127 and be rated as T4AL 250V.
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A

CAUTION

Before replacing the fuse, turn Ella off and disconnect the power cord. If a fuse often
requires replacement, Ella could have an electrical problem. Do not use her. You could
expose yourself to electrical shock. Contact ProteinSimple Technical support for assis-
tance.

Avant de remplacer le fusible, éteignez Ella et débranchez le cable d'alimentation. S'il faut
souvent remplacer un fusible, il se pourrait qu'Ella ait un probléme électrique. Ne I'utilisez
pas. Vous risquez de vous électrocuter. Contactez I'assistance technique de ProteinSimple
pour obtenir de l'aide.

High-Voltage Hazard and Precautions

Inside Ella, the computer and monitor are high-voltage electronics. See the computer and monitor precau-
tions before opening the computer or monitor.

A

CAUTION
Do not remove Ella’s main cover; there are no user serviceable components inside and
you may be exposed to high voltage.

Ne retirez pas le cache principal d'Ella; il n'y a aucun composant a l'intérieur que I'utilisa-
teur puisse réparer et vous prenez le risque de vous exposer a une tension élevée.

Laser Light Safety Precautions

A

CAUTION
Using controls, making adjustments, or performing procedures other than those specified
herein may result in hazardous laser light exposure.

L'utilisation des commandes, la réalisation des réglages ou I'exécution des procédures
autres que ceux spécifiés dans les présentes pourraient entrainer une exposition dangere-
use a la lumiére laser.
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Ellaiis a Class 1 laser instrument that houses a Class 3B laser that operates at 640 nm wavelength. Under the
specified operating procedures, Ella does not allow operator exposure to laser light. The laser, with power up
to 40mW, is accessible in Ella’s interior.

A

CAUTION
Do not attempt to gain access to Ella’s interior through any opening. Exposure to laser
light can cause injury. For example, viewing the laser light directly can cause blindness.

Ne tentez pas d'entrer dans Ella par son ouverture. L'exposition a la lumiere laser peut
causer des lésions. Par exemple, regarder directement la lumiére laser peut rendre aveu-

gle.

CAUTION
Use of controls or adjustments, or performance of procedures other than those specified
herein, may result in hazardous radiation exposure.

L'utilisation des commandes, la réalisation des réglages ou I'exécution des procédures
autres que ceux spécifiés dans les présentes pourraient entrainer une exposition a des
radiations dangereuses.

Please observe the following precautions:

Do not remove Ella's main cover. There are no user-serviceable components inside and you may be exposed

to laser light.

Do not continue to use Ella if the main cover or cartridge lid becomes damaged and she is no longer light-
tight. Contact ProteinSimple immediately to arrange for repair.

Caution Markings

Table 1-2 includes the caution markings that appear on Ella.
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Symbol Description

CAUTION. Refer to the accompanying documentation.

Reportez-vous a la documentation d'accompagnement.

NRTL approval mark. Electrical safety approval to UL61010-1:2012; EN61010-1:2010;
CAN/CSA C22.261010-1:2012.

® P

3

The manufacturer's assurance that the product meets the essential requirements of all
relevant EU directives.

N
m

Separate collection is necessary for electrical and electronics equipment. Please contact
ProteinSimple for disposal instructions.

| 24

Table 1-2: Label and symbol descriptions.

Moving Ella

Ella is a sensitive optical instrument and can be damaged if moved improperly. Dropping her may result in
damage to the instrument. Always power Ella down prior to moving her. See “Shutting Down the System” on
page 25.

Interconnections: Ella to Computer

NOTE: Only one Ella instrument can be connected and controlled per PC or laptop. Multiple instruments
cannot be connected to the same PC or laptop.

Ella has three cables connected (Figure 1-2):

1. AC power cable. This is used to supply AC power to Ella. The AC power cable shall have IEC 320 female
connector on one end (Ella connection) and a country specific male plug on the other end. Power
cables are to be UL listed and CSA certified with amp rating that meets the electrical specification of Ella.

2. Ethernet cable (black). This is for communication with the high-speed camera inside the instrument.

3. USB cable. This is for communication with all other capabilities of the instrument.
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USB Cable

Ethernet Cable

AC Power Cable

Figure 1-2: Ella connections.

Ella System Interconnections

Follow the included instructions provided by the computer manufacturer to properly assemble the PC into
the Monitor Stand and attach the display. Use the following guide for interconnecting Ella, the PC, monitor,
wireless keyboard, mouse and barcode scanner.
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v AC Power

ol

a—— PC i
. USB Cable D Monitor
Ethernet Cable Display Cable

USB Cable

N

LTI r
F r"" m
|
Barcode Scanner Wireless Mouse & Keyboard

Figure 1-3: Ella connections to PC as well as supporting peripherals.

Embedded PC connections (Figure 1-4):
In order left to right. Make sure cables are routed as shown before attaching to monitor stand.

1. USB-C port (for display). Connection to monitor using the provided 0.6-meter USB-C to DisplayPort
cable.

2. Power input. Connection to PC power supply.

3. Ethernet. Connection to Ella.

IMPORTANT

For proper instrument functionality, the ethernet the ethernet connection to the Ella must use this
port. For local network connections use the external USB-C port on the side of the monitor stand
with included adapter cable or use WiFi.

4. USB port. Connection to Ella.
5. USB port. Connection to monitor using the provided 0.6-meter USB-A to USB-B cable.
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Figure 1-4: Embedded PC interconnections.

Embedded PC connections (Figure 1-5):

In order left to right:

1. Power input. Connect monitor power cable.
2. Unused HDMI port.

3. DisplayPort. Connection to embedded PC using the provided 0.6-meter USB-C to DisplayPort cable.
4. Unused VGA port.

5. USB-B port. Connection to embedded PC using the provided 0.6-meter USB-A to USB-B cable.

6. Unused USB port.

7

USB port for keyboard/mouse receiver. Connection to wireless mouse and keyboard.
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Figure 1-5: Monitor back pan.

Embedded PC connections (Figure 1-6):
Connection to ports on side of monitor stand are as follows (top to bottom):

1. USB-C port. Optional connection to LAN using included USB-C to Ethernet adapter (not shown).

NOTE: Your local network can also be connected via WifFi.

IMPORTANT

Do not use this USB-C port with the adapter to connect to the Ella. For proper instrument function-
ality, the ethernet connection to the Ella must use the dedicated port on the bottom of the embed-
ded computer shown in the earlier section.

2. USB port. Connection to Barcode scanner. Listen for the confirming "beep, beep” when connected.
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Figure 1-6: Monitor stand side view showing Barcode scanner and optional LAN (adapter not shown) interconnections.

Additional images showing proper cable routing (Figure 1-7):

Figure 1-7: Clockwise: Side, lower front, lower rear (showing both monitor cables from the PC coming out the back looped
once around the Ella cables and then out the front to monitor).
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Ella with Laptop

To set Ella up with a laptop computer and stand please refer to Figure 1-8. The laptop stand allows the com-
puter to sit directly on top of Ella. The base of the stand has cutouts for Ella’s back feet.

By B -1, I I3 _-._1 o

———

Cutouts for Ella’'s Back Feet

Figure 1-8: Setting up the laptop stand with Ella.

For interconnecting Ella with a laptop please refer Figure 1-9.

Laptop Power Supply

USB Connection

Ethernet Connection

Ella Power Supply

Figure 1-9: Laptop back panel interconnections.
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Additional laptop connections:

- Barcode scanner. Connect this to any USB port (Figure 1-10). Listen for the confirming “beep, beep”
when connected.

Barcode Scanner
USB Connection

Figure 1-10: Laptop barcode scanner connection.
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Contacting Customer Service

For customer support, technical support, or ordering information, contact ProteinSimple using the following
information, or visit proteinsimple.com.

Customer Service

Telephone
1-408-510-5500, option 1
1-888-607-9692, option 1 (toll free, US and Canada only)

Fax

1-408-510-5599

E-mail
techsupport@bio-techne.com

Web
www.proteinsimple.com

Address
ProteinSimple

3001 Orchard Parkway
San Jose, CA 95134
USA

Technical Support

Telephone

1-408-510-5500, option 3

1-888-607-9692, option 3 (toll free, US and Canada only)
E-mail

techsupport@bio-techne.com
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Chapter Overview
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Ella System Components

Starting and Shutting Down Ella
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Introduction

Ellais a fully automated cartridge-based system that allows you to perform single analyte, multi-analyte and
multiplexed immunoassays with the specificity of a traditional single-plex ELISA (enzyme-linked immuno-
sorbent assay).

Using Ella you can:

- Automatically execute an immunoassay protocol

- Automatically acquire and process intensity data

- View and analyze intensity and concentration data

-+ Extract and save intensity and concentration information for application-specific analysis

Ella System Components

Ellais comprised of five main components. The Ella instrument, Simple Plex cartridges, a bar code scanner, a
personal computer with dedicated software, and a verification cartridge.

Ella

A main component of the Ella system is a bench top analyzer with no on-board fluidics which significantly
cuts down on waste and required preventative maintenance. Designed with a “load and go” philosophy in
mind, Ella controls the microfluidic assay by precisely manipulating volumes, flow rates, and flow patterns
without human intervention. Following the assay portion of a run, Ella automatically performs fluorescence
scanning, raw data processing, and calculates RFU (relative fluorescence units) and concentrations on a per
analyte, per sample basis.
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proteinw

Figure 2-1: Ella system.

Simple Plex Cartridges and Assays

The assay-ready cartridge is available in three validated formats: a single-analyte cartridge for up to 72 sam-
ples (72x1) and three multi-sample, multi-analyte cartridges for up to 4 analytes on 16 samples (16x4) or 32
samples (32x4), or up to 8 analytes on 32 samples (32x8). The cartridge is developed with a panel unique to
your research to allow you to scan the barcode, input your samples and buffer into the cartridge, place the
cartridge in Ella’s cartridge holder, and run the cartridge with the Simple Plex Runner GUI. The Ella platform
also accommodates 48-Digoxigenin cartridges that leverage user-defined reagents for custom assay devel-
opment.

Each cartridge has many sample inlets. Every individual sample inlet has ‘n" dedicated channels where 'n"is
the plexity of the cartridge. A single channel contains three Glass Nano-Reactors (GNR) that are functional-
ized with capture antibody, so you obtain three reportable results for each sample's analyte. The GNR con-
tains the immunoassay, and is based on R&D Systems reagents to ensure high quality and reproducible
sensitivity. The collection of GNRs in a given channel, in a given sample inlet, on a given cartridge are the
basis of the set of measurements produced when running a Simple Plex Cartridge.
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AN
RDsystems ™\

abiotechne brand

Figure 2-2: 72x1 Simple Plex Cartridge for 72 samples and 1 analyte.

.
RDsystems
abiotechne brand

Figure 2-3: 16x4 Simple Plex Cartridge for 16 samples and 4 analytes.
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RDsvstems

abietechne brand

Figure 2-4: 32x4 Simple Plex Cartridge for 32 samples and 4 analytes.

protein RDsvstems
. abietechnebrand ¢

€cbcbDcDbDcDbDCcDCDCDCD

C DCDCDCDCDCDCDCD

. 19 20 21 22 .
BUFFER (1mL)
27 28 29 30

C DCDCDCDCDCDCTDCTD

33 31 35 36 e
BUFFER (1mL)
2 42 43 44 45 46

M cbocpbDcpDCcCDCDCDCDC DJ

C= Capture .

D= Detect

Figure 2-5: 48-Digoxigenin Cartridge for custom assay development.
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RIDsvystems
abietechne brand

Figure 2-6: 32x8 Cartridge for 32 samples and 8 analytes.

Bar Code Scanner

The Ella system includes a general purpose hand-held 2D imager that is capable of scanning both 1D and
2D barcodes omni-directionally.

Every cartridge kit shipped from ProteinSimple is labeled with a data-matrix 2D barcode that contains all rel-
evant cartridge kit data including:

- Lotinformation
- Biomarker panel information
- Cartridge configuration information

Each cartridge run begins with scanning the cartridge kit barcode so as to provide the user with all the
salient cartridge kit information, and the software with the necessary data to perform the cartridge run and
raw data processing.

PC and Simple Plex Software

The PC and Simple Plex software included with Ella allow you to control the system. Simple Plex software is
comprised of two GUI (graphical user interface) applications:

-+ Simple Plex Runner

-+ Simple Plex Explorer
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Simple Plex Runner is for configuring and running cartridges. Simple Plex Explorer is for organizing, analyz-
ing, and viewing your data.

NOTE: Ella comes with 10 Simple Plex Explorer licenses. Users can purchase additional licenses if needed.

Verification Cartridge

The verification cartridge is provided as a reusable reference necessary for performing an instrument self-
test. See "Ella Self-Test” on page 73 for details.

Starting and Shutting Down Ella

Follow the procedures in this section which describe how to position, start up and shut down Ella.

NOTE: When positioning Ella, care should be taken so that her back surface will have adequate clearance
such that an operator's hand can access the power switch and power supply cable (see Figure 2-7). With
operator facing the front of Ella, the power switch and power supply cable are located at the back panel,
lower left side.

Starting the System

To start Ella:

1. Power up Ella.

2. Power up Ella's computer and monitor.

3. Login to PC and start the Simple Plex Runner software.

NOTE: Systems are delivered with a local admin account as follows:
User Id: Ella
Password: Ella
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Power Source:
100-240VAC
50/60Hz, 300VA

Fuse:
T4AL 250V

Figure 2-7: Ella power switch.

After power up of Ella the status light will illuminate (Figure 2-8). See Table 2-1 for a description of the status
light.

Description Status

Green Ellais powered and ready for use

Blue Ellais running a cartridge

Blinking red An error has occurred (Ella may optionally sound an
audible alarm)

Table 2-1: Status light indications.
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protein@

Figure 2-8: Ella status light.

Powering Up Ella

1. Press the power switch on Ella’s back panel (see Figure 2-7).

Powering Up Ella’s Computer

1. Press power on the computer.

2. Loginto Windows®.

Starting the Simple Plex Runner Program

1. Wait until Ella’s status light indicates ready. If the status light indicates something other than ready, an
error may appear when you start the software.

2. From the Windows Start menu, select Programs > Simple Plex> Simple Plex Runner, or double-click
the Simple Plex Runner icon on the desktop.

The Simple Plex Runner application opens on the computer desktop.

Shutting Down the System

To shut down Ella:

1. Close the Simple Plex Runner application by doing one of the following:
a. Click File > Exit on the menu

b. Click Close (X) in the upper-right corner of the Simple Plex Runner application.
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]

2. Shut down Ella's computer

3. Turn Ella off by pressing the power switch on the back panel.
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Chapter 3:

Running Cartridges

Chapter Overview
Introduction
Barcode Labels
Prepare Samples and Reagents
Prepare Cartridge

Configure and Run with Simple Plex Runner

User Guide for Ella



Introduction page 28

Introduction
To run a cartridge you'll need:
- Your samples

-+ Your barcode labeled Cartridge Kit (Figure 3-1) that contains the following:
-+ Wash Buffer A
« Sample Diluent component(s)

- Cartridge

SPCKA
CCL2IMCP-1, 1L,

Lot: 2765  gypiration: Apr-
Kit: 33337

Figure 3-1: Cartridge Kit.

The typical run sequence is:
1. Prepare reagents.
2. Prepare cartridge.

3. Configure and run using the Simple Plex Runner application.
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Barcode Labels

Kit Label
Found on the outside of the cartridge bag, highlighted in Figure 3-2.

protein

SPCKA-PS-000469
CCL2/MCP-1, IL-6, TNF-a, VEGF-A
Store at 2-8 °C.
Cartridge: 37238

Lot: 2765 gypiration: Apr-27-2018

Kit: 33337

Figure 3-2: Kit barcode label.

Cartridge Label

The cartridge barcode label (see Figure 3-3) is located directly on the cartridge and is used to track the car-
tridge to the Kit. This cartridge barcode label is used as a confirmation that the cartridge being run matches
the Kit. The default setting of requiring a cartridge to Kit confirmation can be disabled in Runner Settings.

Cartridge ID barcodes are found in different locations based on the cartridge type as shown in Figure 3-3.
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pro\ein@ I protein@
BUFFER (1mL) BUFFER (1mL)

SAMPLE

1 2 E 4 5 6 7 8

BUFFER (1mL) BUFFER (1mL)
S

RDsvysrems o Mmoo PR
abiotechne brand

##01-2-31895 &

Figure 3-3: Cartridge ID barcodes: 16x4 (left), 32x4 and 32x8 (middle), 72x1 (right). The 48-Digoxigenin cartridge’s barcode (not
shown) is at the top of the cartridge.

Prepare Samples and Reagents

Plasma (EDTA or Heparin) and Serum Samples

Serum and plasma samples prepared with the protocol recommended on the assay specification sheet, and
not containing visible particulate matter, do not require additional centrifugation before use in a Simple Plex
assay.

For serum and plasma samples containing visible particulate matter it is recommended to remove particu-
lates by centrifugation and dilute according to the instructions in the Assay Specification Sheets. The
method below is designed to preserve sample but may by adjusted as needed based on sample availability
and particulate content. The method below simulates the sample preparation for the 1:2 minimum required
dilution (MRD) used in most Simple Plex assays. For higher dilution factors serial dilution may be necessary
for accuracy.

Centrifugation for Serum and Plasma Samples

1. Aliquot 35 L of serum or plasma into a microcentrifuge tube.
2. Centrifuge at 8,000-10,000 g for a minimum of 4 minutes.

3. Aliquot 30 uL of the appropriate sample diluent into another microcentrifuge tube.
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4. Once centrifugation is complete, remove 30 uL sample taking care not to disturb the pellet at the bot-
tom.

5. Add the 30 L of centrifuged sample to the 30 L of aliquoted diluent and mix thoroughly.
6. Pipette 50 pL of the 1:2 diluted sample into the specified cartridge inlet.

Other Specimen Types

Optimal dilutions should be determined by the end user.
Custom Assays

When working with the 48-Digoxigenin cartridge it is necessary to conjugate affinity reagents with digoxi-
genin and biotin prior to the assay.

Prepare Cartridge

NOTE: When handling cartridges, it is recommended that gloves be worn at all times and the plastic
backer be removed only immediately to placing the cartridge into Ella.

Procedure
1. Scan the kit barcode on the outside of the cartridge vacuum bag.
2. Remove the cartridge from the vacuum bag.

3. Scanthe cartridge barcode.

NOTE: If the cartridge is past it's expiration date a warning will be displayed. This does not prohibit the car-
tridge from being run.

4. Pipette volumes into the cartridge in the following order:
a. Wash buffer as described on your cartridge insert.
b. Diluted sample as described on your cartridge insert.
5. Peel off the protective lining from the bottom of the cartridge.

6. Place the cartridge into Ella’s cartridge holder.
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NOTE: After removing the lining, use caution to not touch the bottom of the cartridge or place it on any
surface.

7. Close the cartridge clamp and lid.

The sequence for preparing the cartridge just described is pictorially portrayed in Figure 3-4 through
Figure 3-16.

protein

SPCKA-PS-000469
CCL2/MCP-1, IL-6, TNF-a, VEGF-A
Store at 2-8 °C

Lot: 2765 gypiration: Apr-27-2018
" .  Cartridge: 37238

Kit: 33337

SPCKA-PS-000469
CCL2/MCP-1, IL-6, TNF-a, VEGF-A
Lot: 2765 £y istion: pra7.2018  Sloreat2:8°C
Kit: 33337 xaw  Cartridge: 37238

Figure 3-5: Scanning the barcode.
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SPCKA-PS-000460
COL2MCP.1
Lot 2765

Kt 33337

L8, TNF-0, VEGF-A
Expiraion Apr-2T-2018 Store at 2.4 c
it Carndge: 37238 ‘!

Figure 3-6: Removing cartridge protective casing.

| — SAMPLE =

3 4 ;
iy )

BUFFER (1mL) BUFFER (1mL)

SAMPLE
10 11 12 13 14 15 16
BUFFER (1mL) BUFFER (1mL)

RDsvstems
abiotechne brand

Figure 3-7: Scanning cartridge barcode for confirmation (optional).
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Comie LB TSI VESEA
ST D Yot wo

BUFFER (1mL) BUFFER (1mL)

RDsvystems
abiotechne brand

Figure 3-8: Loading buffer.

BUFFER (1mL) BUFFER (1mL)

BUFFER (1mL) BUFFER (1mL)

ST s SR e e %
#01-2.35829

BUFFER (1mL} BUFFER (1mL)

SAMPLE

BUFFER (1mL) BUFFER (1mL)

RDsvstems
a bietechne brand

Figure 3-9: Loading sample.
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Figure 3-10: Removing protective lining.

Figure 3-11: Ella open door.
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Figure 3-12: Opening cartridge clamp.

Figure 3-13: Ella open door and clamp.
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Figure 3-14: Loading cartridge in Ella.

Figure 3-15: Closing cartridge clamp.

User Guide for Ella



Configure and Run with Simple Plex Runner page 38

Figure 3-16: Closing door.

Configure and Run with Simple Plex Runner

Introduction

The Simple Plex Runner application is a graphical user interface (GUI) application that follows a ‘wizard' like
motif in that it guides you through the process of:

1. Configuring your run (during this phase you can use the Next and Back buttons until you are ready).
a. Scanning your kit and cartridge barcodes.
b. Specifying where you want to store the kit results.
C. Assigning your samples to the cartridge inlets.
d. Confirming your run setup.
2. Observing run progress (from this point forward the process is automatic).
a. Assay protocol progress.
b. Fluorescence scan progress.

3. Viewing and exporting kit results.
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Starting the Simple Plex Runner Program

1. Wait until Ella’s status light indicates ready. If the status light indicates something other than ready, an
error may appear when you start the software.

2. From the Windows Start menu, select Programs > Simple Plex > Simple Plex Runner, or double-click
the Simple Plex Runner icon on the desktop.

The Simple Plex Runner application opens on the computer desktop as shown in Figure 3-17. As highlighted

in Figure 3-17, on each screen of the Simple Plex Runner application the run sequence is displayed in the left
list box and can be used as a reference as you progress through a cartridge run.

('[:3 Simple Plex Runner - v3506 eSS )
File Settings Tools Help
i New Kit pleliElylsimple
Inlet Assignments
Confirm Selections 1) Scan Kit Barcode
Running Assay
Running Scan Kit ID
Kit Results
Lot Number ‘ ‘
Expiration Date | |
Cartridge Type B
Analytes
Species Type ‘ ‘

2) Scan Cartridge Barcode

Cartridge ID

3) Confirm or Change Output File Name

Kit Results File Name: | [ Change

Please scan kit and cartridge barcodes before proceeding.

21 CFR Part 11 Mode Enabled _:

Current User: Colin Merrifield (CELLBIOSCIENCES\ cmenfield)

Figure 3-17: New Kit screen.
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Configuring Your Run

Kit Barcode Screen

When displayed, the New Kit screen will set the cursor focus in the Kit ID text box. At this point, use the bar-
code scanner to scan the kit barcode. The kit barcode will be parsed and the kit information will be displayed
on the screen.

The most relevant kit information is:

Kit ID. The unique factory serial number of the kit. The Kit ID is utilized for the kit results filename as
KitXXXXXX.cydat where XXXXXX is the zero padded Kit ID. For your work with Ella, it is recommended
that the Kit ID be used as the primary identifier for your kit results data. If you ever have the need to
contact Customer Service concerning a kit, you will be asked for the Kit ID number.

Analyte Names. Analyte Names lists the current panel of biomarkers.

Cartridge ID. The Cartridge ID is obtained by scanning the barcode on the cartridge. This is option-
ally required as a confirmation that the cartridge matches the Kit scanned.

Species Type. Specifies the analyte species for which the kit has been validated.

The Kit Results File Name is the folder location where the kit run results file (a *.cydat file) will be saved. The
Simple Plex Explorer application is for subsequently working with *.cydat files after your run.

NOTE: A valid kit barcode is required to execute a run.

Inlet Assignments Screen

Use the screen shown in Figure 3-18 to provide detailed sample information for each of the cartridge sample
inlets. The mouse and keyboard functionality below can be used to select and edit multiple inlets at once.
You can also use the buttons below the inlets list to make selections prior to editing the sample data.
Mouse and keyboard functionality

Left click: Select row and cell.

Shift + left click: Select all rows between current selection and clicked row.

Ctrl + left click: Select clicked row in addition to already selected rows.

Tab: Advance to adjacent cell right. Wraps to next row if on last column.

Shift + tab: Advance to adjacent cell left. Wraps to next row if on last column.

Arrow keys: Moves left, right, up or down to next adjacent cell.

Enter: Completes active data entry.

Escape: Undo active data entry.
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- Defining values: Values can be assigned to rows in unison by selecting all the rows of interest and
then assigning a value to a field. All rows selected will be updated with the same value.

- Sample Type: Once a sample type has been assigned to a row, the relevant information for that type
of sample can be edited. Information that is not relevant to a specific sample type will be greyed out
and populated with N/A for that particular field.

« Defining standards: Once samples have been defined as belonging to a Standard Curve under the
sample type field, they can then have their values defined using the Setup Standard Curve button
at the bottom of the screen.

« Curves can be defined by defining a Top Concentration and then specifying the dilution factor
in the field marked Divisor.

- Allthe analytes can be defined simultaneously by selecting the All Analytes Identical button or
each can be defined individually with unique top concentrations and divisors by deselecting this
option.

- Once this is complete the concentrations will be displayed on the Inlet Assignment screen

- Importing data from previous runs: If your inlet assignments will be similar to a previously run kit,
you can click Import and From Previous Kit Results File. Then select the previously run CYDAT file,
and specify only the particular columns of the previous layout you want to use for the present one by
utilizing the check boxes as shown in Figure 3-20.

+ Importing data from excel:

- Ifyou have your sample information in an Excel worksheet, you can select the target inlets for the
data in Simple Plex Runner, then select the matching number of rows in your worksheet. Next,
drag and drop the worksheet selection onto the runner selected inlets.

- Data will be imported starting from the Sample Name field and continuing with subsequent col-
umns. The information in Excel must match the column progression in the Inlet Assignment
screen.

- Copy/paste functionality: Information for entire rows can be copied and pasted to replicate those
setting for other rows using the Copy and Paste buttons at the bottom of the screen. While focus is in
the Inlet column, the copy and paste functionality can also be accessed by using Ctrl + C and Ctrl +
V.

+ Undo functionality:
-+ Undo will roll back the most recent action taken in the Inlet Assignment fields.
- Redo will re-apply the most recent action that was undone in the Inlet Assignment fields.

Entering data on this screen is entirely optional. In other words, you can proceed with a run without entering
any data at this point in your run (although a warning will be displayed, see Figure 3-19). With or without
sample data, the run will execute the full protocol, scan the entire cartridge, and produce RFU results. You
will always have the option of editing the sample data after the run is complete and recalculating concentra-
tions for a given run via use of Simple Plex Explorer.
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111 Simple Plex Runner - v34022 (=@ = |

File Settings Tools Help

(AWM |n|ct Assignments HEEsimple]]

Select Script halyte
Confirm Selections | et | samp Type | Sample Name Diuton Factor | Anlyte Name Known Conc. | Capture Name | Capture Conc, | DetectName | Detect Conc,  Comments
Running Assay
Running Scan
Kit Results

NEEEREHEEINAN NN

5

1

Cartridge Comments:

Assign Inlets and proceed to next step __.

Curent User Bl it 166690

Figure 3-18: Inlet Assignments screen.

-
Incomplete Inlet(s) u

Inlets not fully assigned. Concentration results will only be generated
for inlets where dilution factor is set. Additional inlet assignments can
be done later with Simple Plex Explorer.

[ ok ][ Ccancel

Figure 3-19: Incomplete inlet(s) warning.
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-

Import a Previous Layout s s S - .. - | SR
File to Import From: | C:\Users\Public\Documents\Simple Plex\KitResults\Kit001000(1).cydat -] |5 Browse
Inlet Sample Type ~ Sample Name  Dilution Factor  IL-1b L6 IL-10 THF2 Comments
1 Unknown  §1 2 n/a n/a n/a n/a commerts conceming the sample go here
2 Unknown 52 2 nfa nia nfa n/a
3 Unknown 53 2 nfa n/a n/a n/a
4 Unknown 54 2 nfa n/a n/a n/a
5 Unknown 85 2 n/a n/a n/a n/a
5 Unknown ~ S6 2 n/a na n/a n/a
7 Unknown 57 2 nfa n/a n/a n/a
2 Unknown S8 2 nfa n/a n/a n/a
9 Unknown  S9 2 n/a n/a n/a n/a
10 Unknown 10 2 n/a na n/a n/a
" Unknown S 2 nfa nia nfa nia
12 Unknown 512 2 nfa n/a n/a n/a
13 Unknown  S13 2 nfa n/a n/a n/a
4 Unknown  S14 2 nfa n/a n/a n/a
15 Cortrol Hac 2 1500.00 1500.00 1500.00 1500.00
16 Cortrol Lac 2
ol i

|| Select Columns to Import:
[l Sampls Type Sample Name Dilution Factor Krown Concentration(s) Comments Cancsl

Figure 3-20: Import a Previous Layout screen.

For a given inlet, the sample data is detailed in Table 3-1.
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Field Description

Sample Type - Unknown — sample with an unknown concen-
tration

- Standard — sample with a known concentra-
tion from which to build a standard curve

« Control — sample with known concentrations
of recombinant protein

« Spike — a biological sample with a known
amount of recombinant protein added

Sample Name An alphanumeric string of your choosing.

Dilution Factor Used for computing concentration from RFU. A dilu-
tion factor of 1 is considered neat. A dilution factor of 2
is 1 part sample to 1 part diluent.

Comments Your comments concerning that sample.

Concentration The known concentration of the sample. A single
entry can apply to all the analytes, or you can enter a
value for each analyte.

Analyte Name Applies to 48-Digoxigenin Cartridge. The name or
identifier for the analyte to be measured.

Units The units of concentration used to describe the ana-
lyte measured.

Capture Name The name or identifier for the capture reagent used in
the reaction.

Capture Conc. The units of concentration used to describe the cap-
ture reagent in the reaction.

Detect Name The name or identifier for the detect reagent used in
the reaction.

Detect Conc. The units of concentration used to describe the detect
reagent in the reaction.

Table 3-1: Sample data descriptions.
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If all of your selected inlets have a sample type of Standard, the Setup Std. Curve button will become
enabled. Clicking the Setup Std. Curve button will display the dialog shown in Figure 3-21. With this dialog
you can easily setup dilution series concentrations. Click OK to place the resulting concentrations into the
originally selected inlets and close the dialog.

Setup Standard Curve Concentrations RS
[T Al Analytes Identical IFNg L2 L6 TNFa
Top Concentration Divisor 2000.00 1000.00 1000.00 5000.00
IFNg |2000.00 s B = | 400.00 200.00 200.00 1000.00
IL-2ra [1000.00 =] [0 |= |&0o0 40,00 40,00 200.00
Y o 00 S| s 2| |00 200 200 40,00
z = |32 160 160 200
RIE= 5000.00 cal [ GO = B Y 032 032 160
013 0.06 0.06 032
0.00 0.00 0.00 0.00
With Zerols) Highto Low ok | [ Ccancel

i A

Figure 3-21: Compute Std. Curve dialog.

When you have completed your inlet assignments and clicked the Next button, the Confirm Selections
screen will be displayed (Figure 3-22). You may now review your inputs for accuracy, and optionally export
your prepared run to the clipboard as a tab delimited spreadsheet compatible string.

Clicking Start on the Confirm Selections screen will display a final confirmation prompt as shown in
Figure 3-23.

NOTE: Once a run begins, reagents will be pumped from the inlets to the cartridge interior rendering the
cartridge used. A cartridge is a consumable; only good for a single run.
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Confirm Selections proteinSiiv |

Kit Results File Name C:\U:

Before starting run, please ensure the following:
1) Buffer is loaded into the cartridge-
3) Protective film is removed from bottom of cartridge.
5) Door is closed.

New Kit
Inlet Assignments
Select Script
elect Scri Kit Id 66690 Cartridge Id | 74541 Analytes | ]
Running Assay
Running Scan Inlet Assignments
Kit Results Aoclyte
Inlet | Sample Type | Sample Name Dition Factor  Analyte Name | Known Conc. | Capture Name | Capture Conc, | Detect Name  Detect Conc.  Comments

: <

2

3

4

s

s

7

s

s

»

1)

)

1

nnnnn =5

2) Samples are loaded into the cartridge inlets.
4) Cartridge is clamped into the analyzer.

Confirm selections and click "Start" to begin running cartridge.

Current User: Ella | Kt Id: 66690

Figure 3-22: Confirm Selections screen.

——
Confm s M

S

@ Please confirm that you wish to start the run.

Start

] I Cancel I

Figure 3-23: Run confirmation dialog.

Observing Run Progress
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There are two phases to a cartridge run. The first phase is the Assay phase, and the second is the Scanning
phase. Each phase has a dedicated progress screen, respectively, as shown in Figure 3-24.
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113 Simple lex R

T

(= i)

File  Sett

Help

Confirm Selections

Running Scan
Kit Results

New Kit - . .
iy /\ssay Protocol Running... smplel

Demo Mode Enabled

Assay Protocol Progress

55 Minutes Remaining

Prescan Status

i
I
I
I
I Activated @ Scan Progress: |
Cartridge Status
I Cartridge Detected @ DoorClosed @  ClampClosed &
I
| (=]
Current User cstamwood | Kit & 1000 | Running Assay - 55 Miutes Remaining

[ s o052

(= i)

File Settings Tools Help

Confirm Selections
Running Assa

Kit Results

New Kit - . .
ugyI—_ Running Scan... gsimple )}

Demo Mode Enabled

Scan Progress
Cartdge Progress | \

et Progress | \

Cartridge Status

Cartridge Detected @ Door Closed @ Clamp Closed &

Current User: cstanwood | Kit d: 1000 | Running Scan - 12% Completed

Figure 3-24: Running Assay screen (top) and Running Scan screen (bottom).
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A run will require approximately 75 minutes. The majority of this time is the Assay phase during which the

following sequence is followed:
1. Prime with buffer

Flow sample

Wash with buffer

Flow detect

Wash with buffer

vk W
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6. Flow dye
7. Wash with buffer

In parallel with the Assay phase, Ella also performs a pre-scan that locates the exact scan locations and focus
positions in preparation for running the scan in the second phase. When Ella completes the Assay phase the
run will automatically proceed from the Assay phase to the Scanning phase and the screen will transition to
the Running Scan screen.

During the Scanning phase of your run, Ella performs a fluorescence scan of each dedicated analyte channel
for each sample inlet, and processes the raw scans into a set of RFU results. For example, if the cartridge has
16 sample inlets and a 4 analyte biomarker panel your run will produce 64 RFU results.

During your run you can opt to cancel the run by clicking the Abort button displayed on the Running Assay
and Running Scan screens. If you opt to cancel you will be prompted to confirm that you wish to cancel your
run and reminded that canceling is an irreversible option.

When Ella completes the Scanning phase, the run will conclude and the screen will transition to the screen
shown in Figure 3-25, the Kit Results screen.

Viewing and Exporting Kit Results

Your run results (see Figure 3-25, Kit Results screen) are initially displayed in a dashboard style such that you
can view every RFU/concentration for each GNR for each analyte in each sample inlet. If you opted to pro-

ceed with your run without providing complete sample data the results displayed will be RFUs only. In this
case, you may subsequently use the Simple Plex Explorer application to complete the sample data and cal-
culate concentrations from your runs RFU results.

23 Simple Plex Runner - v34042 =[E] =

File Settings Tools Help Demo Mode Enabled

New Kit % N .
rupwim— Kt Results gsimple )}

Confirm Selections | kG 1d: 1000 - Cartridge Id: 20357
Running Assay © Resuts Summary

Running Scan Analytes: IFNg, IL-2ra, IL-6, TNF-a
R Comments

TFg (1010Q) 1L2ra (1010Q) 16 (1010Q)
NRs | Mean... RFU... |Mean Conc.... | Conc. .. |GNRs |Mean ... RFU... |Mean Conc....  Conc

NRs | Mean
v 28 12

Inket | Sample

»
e
R ANEY)
v L 12
- 26 083
v et 11
v 284 204
v 121
~le 12
v 22 s
-3 1e
v 18 0%
v 187 ses
v 185 00
vy 1w

“
F
&
&
“
2

- um st

Fiter GNRs By: [RFUCV =] Threshold (2CV) (100 2] (< Addiional Optons Boot 4|

Current User cmerifield | it s 1000

Figure 3-25: Kit Results screen.

User Guide for Ella



Configure and Run with Simple Plex Runner page 49

Concentrations are calculated using the factory calibration curves provided in the cartridge kit barcode and
entered into the software when you scanned the kit barcode while configuring your run. Using the Simple

Plex Explorer application, you may subsequently build and utilize alternative calibration curves for calculat-

ing concentrations from RFU results.

Using the Export button allows you to export your results to the clipboard as a tab-delimited spreadsheet
compatible string, a pdf file or a format compatible with your LIMS.

GNR Filtering (as discussed in GNR Filtering) is also available on the Kit Results Screen and any changes may
subsequently be saved.

Simple Plex Runner Settings

Clicking Settings > Application from the menu will display the Settings Dialog as shown in Figure 3-26.
Clicking on a row in the settings dialog will display a detailed description of the selected item at the bottom
of the dialog. These descriptions are provided in Table 3-2 for reference. If changes are made the Save button

will be enabled.

Application Settings n
B2 |
~ 21CFR Part 11
Use21CFRPart 11Mode False
AutoLockInactivityMinutes 10
LogoutWhenDone True
AMlowOutputFilePathChange True
~ Data
KitResultsFile Defautt Folder C:\Users\Public\Documents\Simple Plex\KitResults
AMlways Show3DecimalsForCancentration False
~ Data - Kit Resuits File Defaults
GnrFitter RfuCV
GnrFiterPercentCWThreshold 10
UseSample Standard Deviation False
ResultWaming Use Filter Setting
ResultWamingHighCVPercent Threshold 10
ResultWaming32x8 Off
ResultWaming32x8HighCVPercent Threshold 20
~ Demo Mode
DemoModeEnabled False
~ Diagnostic and Backup Data
KitRunDataRepositoryEnabled True
KitRunDataRepositary C:\ProgramData\Simple Plex\Kit RunDataRepository
LocalKit RunDataRepository Auto Purge Enabled True
LocalKit RunDataRepository AutoPurge Days ToRetain a0
Generate2DMeasure ScanData True
v Generic LIMS
AutoExport Kit Results ToGenericLIMSFile False
Generic LIMSExport File DefaultFolder C:\Users\Public\Documents\Simple Plex\KitResults
Generic LIMSAuto ExportColumns Same Asimport False
ShowConcentrationOutOfRangeIndicationForExport True
Generic LIMSImport File Default Folder C:\Users\Public\Documents\Simple Plex\KitResults
UseGenericLIMSImportFile Default Folder False
~ Other
ComPortName COM3
Barcode ScannerComPortName COM4
BeepOnRunEmor True
RequireCartridge Barcode Scan True
v Self Test
SelfTestDataRepositary C:\ProgramData\Simple Plex\Self Test DataRepository
Kit ResuiltsFileDefault Folder

The common directory in which to output the kit results fils (" cydat).

Figure 3-26: Simple Plex Runner Settings dialog.
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Parameter Description

Use21CFRPart11Mode

Determines whether or not to use 21 CFR Part 11 support (logins,
audit trails, data encryption, etc.). 21 CFR Part 11 support must be
activated for this setting to take effect.

AutolocklnactivityMinutes

Determines the length of a period of inactivity before the applica-
tion screen automatically locks whenin 21 CFR Part 11 mode. Set
to 0 to disable this feature.

LogoutWhenDone

When true (default), the current user is logged out after Done is
selected from the Kit Results panel. When false, the current user
remains logged in and the application proceeds to the New Kit
panel.

AllowOutputFilePathChange

When false, the kit results file name and location cannot be
changed. This also applies to the generic LIMS export file (if
enabled). This setting only applies when in 21 CFR Part 11 mode.

KitResultsFileDefaultFolder

The common directory in which to output the kit results file
(*.cydat extension).

ShowConcentrationOutOfRange-
IndicationForExport

When true, out of range concentration values for generic LIMS
exports are shown as the dilution factor scaled LLOQ or ULOQ
with a prefix of '<' or '>' (such as '<2.00" or >5000"). Otherwise if
false, out of range concentration values are left blank.

GnrFilter

The filter used to select the resulting GNRs. None indicates select
all GNRs found. RFU and Concentration CV performs a GNR outlier
removal if the percent CV for all three GNRs is above the specified
threshold.

GnrFilterPercentCVThreshold

The percent CV threshold used by GnrFilter.

UseSampleStandardDeviation

Preference used for calculating percent CV. If checked, sample
standard deviation is used. Otherwise, population standard devia-
tion is used (the default).
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Parameter Description

ResultWarning

This setting applies to all cartridge types except 32x8. Determines
if an analyte result should be shaded light pink in the Results
Summary View when the relevant CV percent is greater than or
equal to the specified threshold. If Use Filter Setting is selected,
the applicable CV and threshold are determined from the GnrFil-
ter and GnrFilterPercentCVThreshold settings. The default
value is UseFilterSetting.

ResultWarningHighCVPercent-
Threshold

The percent CV used by ResultWarning. The default value is 10.

ResultWarning32x8

This setting only applies to cartridge type 32x8. Determined is an
analyte result should be shaded light pink in the Results Sum-
mary View when the relevant CV percent is greater than or equal
to the specified threshold. The default value if Off.

ResultWarning32x8HighCVPercent-
Threshold

The percent CV used by ResultWarning32x8. The default value is
20.

DemoModeEnable

Application will operate in demo mode and does not require a
connected Ella system.

KitRunDataRepositoryEnabled

Determines if the Kit Run Data Repository (KRDR) is enabled. The
KRDR includes all diagnostic run data for a kit as well as a backup
of the kit results file. If disabled, kit result file recovery will not be
possible.

KitRunDataRepository

The root directory in which to store all diagnostic run data for a kit
as well as a backup of the kit results file. Folders are organized by
date and then by kit ID with run time.

LocalKitRunDataRepositoryAutoPur-
geknabled

Determines if older data in a local Kit Run Data Repository (KRDR)
is automatically purged. Auto-purge functionality is not applied
to a KRDR on a network drive or share.

LocalKitRunDataRepositoryAuto-
PurgeDaysToRetain

Determines the number of days of data to retain if LocalKitRun-
DataRepositoryAutoPurgeEnabled is set to true.

AutoExportKitResultsToGeneri-
cLIMSFile

Determines whether or not to automatically generate a generic
LIMS export file at the end of the run.

Generate2DMeasureScanData

Generates additional diagnostic data for measure scans. Will
increase space used by the Kit Run Data Repository by as much as
25%. The default is true.

User Guide for Ella




Configure and Run with Simple Plex Runner

page 52

Parameter Description

GenericLIMSExportFileDefaultFolder

Default directory location in which to output the auto-generated
generic LIMS export file (*.csv).

GenericLIMSAutoExportColumns-
SameAsIimport

Determines whether or not the automatically generated generic
LIMS export file uses the same columns as the import file (if avail-
able). Otherwise the default format is used.

AlwaysShow3DecimalsForConcen-
tration

Always show 3 decimals for concentration. The default is for the
number of decimals displayed to be based on how many signifi-
cant digits there are in the measurement. This setting also
changes how concentration values are exported.

GenericLIMSImportFileDefaultFolder

Default directory location for choosing the generic LIMS import
file (*.csv).

UseGenericLIMSImportFileDefault-
Folder

Determines whether or not to use the default directory specified
in the GenericLIMSImportFileDefaultFolder. If the default
directory is not used then the directory will default to the most
recent used.

ComPortName

Communication port to instrument.

BarcodeScannerComPortName

Communication port to barcode scanner.

BeepOnRunError

Indicates if Ella should beep when an error condition is encoun-
tered during a run to attract the attention of the user.

RequireCartridgeBarcodeScan

Requires the cartridge barcode to be scanned on New Kit panel.

SelfTestDataRepository

The root directory in which to store all self test data. Folders are
organized by Ella number and then by test date and time.

Table 3-2: Runner settings.

Clicking Settings > Analyzer > Description from the menu will display a dialog box that can be used to
rename the Ella instrument. The instrument name defined here is written to the instrument's on-board soft-
ware and will persist even if the computer is changed. This name will be associated with all .cydat files pro-

duced by the instrument.
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The Data Repositories

Simple Plex Runner software is configured to store the data associated with every kit and self-test run. The
data is placed into data repositories that are organized by date and run.

The purpose of the Kit Run Data Repository (KRDR) is to:
1. Provide for backup/recovery of CYDATSs for every kit run.

2. Provide diagnostics data in the unlikely event of system issues.

The purpose of the Self-Test Data Repository (STDR) is to:
1. Provide a retrievable history of all Self-Test runs.
2. Provide diagnostics data in the unlikely event of system issues.

The location of the repositories may be configured using the Simple Plex Runner application settings, and
may be specified as a local drive or a network drive. The network drive option is useful because it may be

included in regular network data backup, and if you have more than one Ella they can all be configured to
use the same network repository which lends itself to Simple Plex data centralization. The KRDR capability
may be enabled or disabled. If enabled and using a local drive configured to auto-purge files older than a

configurable number of days, this ensures the repository does not fill up a local drive with data.

Recovering a CYDAT

If you are using the KRDR and have misplaced or lost a CYDAT from a run, you may recover that Kit's CYDAT
using the Recover Kit Results option located in Simple Plex Runner software under File > Recover Kit
Results. Selecting this option will locate the specified Kit CYDAT in the repository and make a copy of it to
the desired storage location.

Browsing/Retrieving the Self-Tests

By selecting Self-Test History located in Simple Plex Runner software under Tools > Self Test History, you
can view a list of all Self-Tests in the repository organized by Ella system and date. You also have the option to
retrieve/save one or more Self-Test Reports, and any Self-Test's results details may be viewed.
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Chapter 4:

Analyzing Data

Chapter Overview
Introduction
Starting the Simple Plex Explorer Program
GUI Features

Activating your Simple Plex Explorer Installation
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Introduction

The Simple Plex Explorer application is used to work with your results.

There are two file formats associated with Ella as presented in Table 4-1.

File Extension Description

Kit *cydat The run results file. Contains:
Kit meta data
Analyte panel data
Factory std. curves
RFU run results data/Individual GNR results
User entered sample data

Calculated concentration data

Curve *.cycurv Stores a user constructed standard curve.

(Known Concentration, RFU) data set used for
curve fitting

Curve fitting results

Table 4-1: Data file types.

Using the Simple Plex Explorer application you can:
Load one or more Kit/Curve files.

Review Kit/Curve files individually and export to a spreadsheet compatible CSV (comma separated
variables) file for further analysis.

Edit individual Kit samples and calculate concentration results based on the new Kit sample data.
'Save' or 'Save As' Kit/Curve files individually.

Aggregate multiple kits for export into a CSV file for subsequent multiple run analysis.

Build your own standard curve using presently loaded Kit/Curve files.

Apply curves to kits in aggregate or discretely.

Re-apply factory curves to a kit.

View individual GNR results and select which GNRs to include in a given channel RFU/concentration
result.

User Guide for Ella



Starting the Simple Plex Explorer Program page 56

Starting the Simple Plex Explorer Program

1. From the Windows Start menu, select Programs > Simple Plex > Simple Plex Explorer, or double-
click the Simple Plex Explorer icon on the desktop.

3

The Simple Plex Explorer application opens on the computer desktop as shown in Figure 4-1. If at this
point you are prompted to activate your Simple Plex Explorer installation please refer to “Activating your
Simple Plex Explorer Installation” for the details of this process.

2. Load Kits and/or Curves you would like to review.

(3 simple Plex Explorer - v.3.40.42

File View Tools Help

Kt ld Analytes Encrypted  Filename: Run Date User Specimen Typels) Species Type Lot Number

[ Curves | Kit Resuts

a bietechne brand

| No Kits Loaded | No Curves Loaded

Figure 4-1: As Launched Simple Plex Explorer screen.

GUI Features

The main navigation features of the Simple Plex Explorer screen are:

The menu bar in the upper left corner of the form.

The Kits and Curves Tabs to toggle between the kit and curve views.
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- Depending on selected view, the loaded Kits or Curves list at the top of the main panel.
«  Buttons to perform actions directly to the right of the Kits or Curves list.
« Astatus strip in the lower left corner of the application form.

« A sub-panel below the Kits or Curves list that will provide the necessary GUI for the present activity.

Kit Results Tab

111 Simple Plex Runner - v35.06 [=[@] = |

File Settings Tools Help i
L B . .
Now kit Kit Results proteingiuE

Vi
Inlet Assignments | Gt 19: 1000 - Cartridge Id: 20357 i S——
Confirm Selections X

Running Assay Analytes: IFNg, IL-2ra, IL-6, TNF-a

Runmni Scan Comments:

TFrg L-za i
Inlet  Sample GNRs  MeanRFU RFU %CV Mean Conc... Conc. %CV GNRs MeanRFU RFU%CV  MeanConc.. Conc. %CV GNRs MeanRFU RFU %CV Mean Conc... Conc. %CV GNRs MeanRFU RFU %CV | Mean Conc..

b1 3 v 7715 042 3 v 1305 085 3 v 2140 143 3 v 1289 120

2/ 3 - BLI9 045 3 v 1280 149 3 - 2165 150 3 v 1248 165

3 3 v 7645 118 3 v 1264 035 3 v 2266 132 3 v 1247 250

4 3 v 7935 019 3 v 1285 0.2 3 v 2144 154 3 v 1245 142

5 3 v 7427 3 3 v 1215 383 3 v 2104 047 3 v 1260 083

6 3 - 7687 100 3 - 1234 275 3 - 2240 035 3 v 1264 130

7 3 v 7732 104 3 v 1303 153 3 v 2183 13 3 v 1284 204

8 3 v 7940 04 3 v 1201 205 3 v 2143 30 3 v 1360 121

9 3 w7731 153 3 v 1271 045 3 v 2083 015 3 v 1292 L2

10 3 - 7919 038 3 v 1271 14 3 - 2179 178 3 v 1221 055

1 3 v 7476 13 3 v 1252 062 3 v 2124 081 3 v 1231 194

12 3 v 7836 081 3 v 1236 044 3 v 2017 551 3 v 1196 0.4

13 3 v 7636 064 3 v 1230 103 3 v 2125 0% 3 v 1157 565

14 3 - 7696 101 3 0+ 1231 254 3 - 2063 338 3 v 1185  0.60

15 3 v 7606 030 3 v 1240 291 3 v 2083 143 3 v 1247 173

U 3 v 7389 087 3 v 1225 100 3 v o213 0§57 3 v 179 09l

T R — L oo
e sovec 101000 cvetn G\ sl — =3

Cumrent User; Calin Merrifield (CELLBIOSCIENCES\cmenifield) | Kit Id: 1000 21 CFRPart 11 Mode Enabled ;

Figure 4-2: Kit screen.

The functionality of the Kits tab as shown in Figure 4-2:

- ltdisplays the details of the kit selected from the list.

+ Change GNR Filtering or Standard Deviation preference.
«  Review/select individual GNRs per channel.

+ You can create a Kit Result Data Summary in pdf format using the Export button in the bottom right
of the screen.

+ You can export a spreadsheet compatible string containing kit data to the clipboard by selecting
Export > To Clipboard.

User Guide for Ella



GUI Features page 58

You can calculate concentration results from RFU results using the original factory calibration curve
by clicking the Apply Factory Curves menu option, available by clicking the Additional Options
button.

GNR Filtering

As briefly described in the “Simple Plex Cartridges and Assays” section, each channel in the 72x1, 16x4, 32x4
and 48-Digoxigenin cartridges contain triplicate GNRs. The channels of the 32x8 cartridge contain four GNRs
split between two different analytes which yields duplicate GNRs. When the assay completes, the channels
are scanned and the resulting data is processed to produce RFU and concentration values for each located
GNR. This is true of GNRs that are 'Located' because there are some circumstances that may result in fewer
GNRs being located in a channel scan. The resulting set of GNRs are then used to produce a channel mean
RFU and mean concentration.

For cartridges formats with triplicate GNRs, filtering is a capability for automatically triggering the removal of
an outlier GNR result from a given channel population. For cartridges formats with duplicate GNRs, there is
no option for filtering. The GNR filtering options are as follows:

None. No filtering will be performed.
RFU. Filtering will be triggered based on the GNR RFU data.
Concentration. Filtering will be performed based on the GNR concentration data.

If filtering is triggered by the GNR population %CV exceeding the threshold, then the outlier removal will
determine the optimal pair of GNRs based on the minimum population standard deviation (or sample stan-
dard deviation if Use Sample Standard Deviation is checked) of the three possible pair combinations.

The results of GNR Filtering may be overridden at any time by simply clicking on a cell in the GNRs column of
the Kit screen. This action and adjusting the GNR Filtering are shown in Figure 4-3. The specific highlighting
logic for what is highlighted when is provided in Table 4-2.

NOTE: The default choice for 'Use Sample Standard Deviation' and ‘GNR Filtering' can be set in the Simple
Plex Runner application settings.
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Click a GNR cell to view
and select. Click OK to
apply changes.

GNR filter settings.
Changes will trigger
reprocessing.
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Gives Kt

Kitld Analytes Enciypted  Filename Run Date User ‘Specimen Type(s) Species Type Lot Number
2 g .16 T o s DsSmple 0721201511 Bl PosnoSenm Horen 5ot
< ,
Kit Id: 12821 - Cartridge Id: 14306
Analytes: IFNg, IL-1b, IL-6, TNF-a
Comments:
G0 [ (5 s
GRS e RFU .. Mean Conc... | Conc .. GNRS | Mean .. |RFU .| Mean Conc.. | Con. .. GNRS | Mean .. RFU .| Mean Conc.. Con. ... GNRS | Mean . RFU .. ean Gonc... Cone
s ovomss 1m 12 2 v ww 1sm s 2w 2 - owol 2y e 3w 2 - wsm sz 1m0 o
5w 2 e s 2 -2 sx a9 sz 3 v me m wm 2@ 3 v s 0% wm o
s as 1w s ws 2 v 1m0 W3 v 2w we 29 3 v zes im was
s v oo sm s 599 5o om s o7 3 v om0 os 2 v nz om 1m0 o
S5 s ass ws 3 v 2 36 26 3 -ws 1w s w5 e ne 4
I/ 1-RFU: 5:85, Conc: 468 2 -4 02 734 0% 2 v 728 500 360 5% 0 v NA  NA
Gz e s - 0s 2a s 3 - mes 1 125 20 3 v 4% 083 6w 101
s ven s s o 3 v s Ay 2 e 2 v mz s sw )
e ST o ([l || 5 - ma 35 26 w2 3 cem 0w W ow 3 v ma s e 22
EdEt e T 2 - ws aw s L5 2w s w7 0 3 voem 2w 9w 505
sovse 1w am 2m s - ws ses s o 3 v ;e 0w w7 ow 3 v as e e 757
s s om 3 o153 v e 0s 4w s@ 3 v mie 1 ae0 23 3 v me os me o7
s e 2 s 26 5 s sm s 2 vm2 o wm x5 v a@ 2% w0 e
s ne 1% s L3 v 0w s s 3 v mm o e ow 3 v 2w 1y s e
2 v om am o 3 v mm o s 68 3 v omam ie 1698 174 3 v ;o5 24 mm 26
15 sonpe 1 s cse sn am st 3 v nos os 3w o7 2 vmm s wes  om 3 vse o 109 53

Ll

Fiter GNRs By: [RFUCV ] Threshod (.Cv) (100 2

[~ Additional Optons

1 Losded | No Curves Losded

Figure 4-3: GNR Filtering on Kit screen.

Results Warning

Results warning is feature that can be used to flag data based on a user specified threshold condition. This
can be defined by either the RFU CVs, the concentration CVs or turned off by the user. The results warning

options for flagging results are accessed under the Additional Options button and include:

« Off. No results warning will be displayed.
« Use High RFU CV. Results warning will color cells based on the GNR RFU CV data.

+ Use High Concentration CV. Results warning will color cells based on the GNR concentration data.

« Use Filter Setting. This synchronizes the results warning threshold condition with the condition

defined for GNR filtering.

User Guide for Ella



GUI Features

111 Simple Plex Runner - v35.0.6

P

File Seifings Tools Help

Inlet Assignments
Confirm Selections

View

@ Resuits Summary
Inlet Assignmerts
Calibration Curves
(© Change History

Nowkit Kit Results protein simplei

Kit Id: 1000 - Cartridge Id: 20357
Analytes: IFNg, IL-2ra, IL-6, TNF-a

Inlet  Sample

Running Assay
Runnmi] Scan Comments:
» 1
2
3
4
5
3
7
8
9
10
11
12
13
14
15
16
.

GNRs | Mean RFU |RFU %CV  Mean Conc... | Conc. %CV GNRs MeanRFU RFU %CYV  Mean Conc.
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79.40
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7636
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76.06
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042
045
118
0.18
320
100
104
0.46
153
0.28
128
081
064
101
0.80
0.87

TFig

Lo

3 v 1305 085
3 v 1280 14
3 - 1264 035
3 - 1285 0.3
3 v 1215 388
3 v 1234 275
3 - 1303 153
3 -+ 1281 205
3 v 1271 045
3 v 1271 1%
3 - 1252 062
3 v 1236 0.4
3 v 1230 103
3 v 1231 254
3 - 1240 291
3 v 1235 100

Conc. %CV GNRs  Mean RFU | RFU %CV  Mean Conc...

2140
2165
2266
2144

O

L T P g N R PR R

Use Sample Standard Deviation

143
1.50
192
154
047
0.25
139
340
0.15
178
0.81
5.51
0.96
3.28
143
0.57

1Ls

Set Result Waming Highlighting Te

N

[Use Fitter setting

Fiter GNRs By [RFUCV. | Threshold 4 C) [~ Addtional Options
Save GNR Selection Changes

Kitresults saved to Kit001000(5) ecvdat in CAUSers\PUBICIDOC e Fiter Setting

off
b Use High RFU CV

3
3

[ P R P T R T T O PR

Conc. %CV  GNRs

AR AR R R R R R |

Mezn RF

Current User, Colin Merifield (CELLBIOSCIENCES\cmerrifeld) | Kt Id: 1000

21 CFR Part 11 Mode Enabled _:

Figure 4-4: GNR Warning settings on Kit screen.

No GNRs Found

For channels where no GNRs are found the cell is highlighted grey. There are two warning messages:

page 60

« No GNRs Detected. Signal processing recognized the channel was unable to distinguish the GNRs
from the background. This can happen when running negative samples.

«Channel Not Found. Signal processing was unable to successfully locate the channel containing the

GNRs.
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Is the Resulting
# GNRs Filtering was Was GNR Population %CV < the
Case # Found Triggered? Removed? Threshold? Highlight Color
1 3 FALSE FALSE NA TRANSPARENT
2 3 TRUE TRUE TRUE TRANSPARENT
3 3 TRUE TRUE FALSE LIGHT PINK
4 2 NA NA TRUE TRANSPARENT
5 2 NA NA FALSE LIGHT PINK
6 1 NA NA NA LIGHT PINK
7 0 NA NA NA LIGHT GRAY

Table 4-2: Kit screen highlighting details.

Curve Tab

The functionality of the Curve tab is shown in Figure 4-5:
It displays the details of the curve selected from the list.

You can export a spreadsheet-compatible string of the curve to the clipboard with the Export to
Clipboard button.

You are able to view all the details of the selected curve.

By clicking on the extreme axis labels of the graph you can edit the range of the axes.
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[ simple Plex Explorer - v.35.0.6 =8 =
File View Tools Help
2
HEs CuvelD  Encrypted | Filename Create Date Author Commets Specimen Type | Seiected Curve
= 351882 No Z\Pivate\cmenifield\SyncFolder\PM Simple Plex\Core Teams\Cha . 01/14/2019 cmerfield PlasmaSerum
Al T 1585%.. No Z:\Pivate\cmenifield\SyncFolder\PM Simple Plex\Core Teams\Cha . 07/03/2019 cmerfield PlasmaSerum
8
2
s
| . r
Curve Datz | Data Foinls IL6 71372019 PlasmaSerum
Parameter Value 10000
Analyte L
Curve ID 158530888298 41256b17-8e TdBeec94%a
Encypted No
Create Date 73019 i
Auther emenfieid o —"
Comments /‘
Specimen Type(s) PlasmaSenum
1004
Species Type Human 7
s 005 e
b 1.00 /
B 324764 EE
4 80317 -3 /
q 077 /
Log 0280
uLog 8630 1 /
01 “ —
oot ul I 1 I I I I I
001 01 1 ] 100 1000 20000
Concentration (pg/ml)
Bxport to Cliphoard
|1 Kits Loaded | 2 Curves Loaded

Figure 4-5: Standard Curve screen.

Build a Curve Screen

From the Tools menu option, select Build a Curve to display the screen for building a standard curve (see
Figure 4-6). A standard curve applies to only one analyte, so in order to proceed you must select an analyte
from the drop-down box in the upper left corner of the sub-panel. Once you make an analyte selection, the
available kits and curves will be displayed in the checklists below the analyte drop-down box.

You can now filter the available results by Specimen Types, Kit Ids, etc. with these checklists.

If you're working with the 48-Digoxigenin Cartridge, there are filtering options for curves created against the
same analyte but they may leverage different capture and detect reagents and concentrations.

There are also additional curve fitting options available for building your own curve. These include 4PL and
5PL curve fits, as well as 1/Y, 1/Y? and None options for weighting the curve fit.

NOTE: Only samples of type Standard will be available for building curves.

The available RFU results from the Kits and Curves selected will be listed in the list to the right of the filter
checklists. Use the list to select the data points to include in your curve by checking the points to include.
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When you check a point to be included in your curve, the point will be displayed on the graph to the right
and if there are more than four data points, a 5-parameter sigmoid curve will be fit to your data using a Lev-
enberg-Marquardt algorithm.

Data points on the curve plot can also be selected to highlight the inlet ID in the curve point dialog box.

Build a Curve G ||
1) Choose Analyte Curve Points 15
10000
Analyts |ILE MEIEAD] Inlst Dilution Factor ~Known Concentration  RFU Concertr
0722 1 1 6630.00 47258 6355
2) Check Kit Files to Use | [/ 7072 2 1 265200 W66 %2
R 3 | 1060.30 15333 1028
Z\Private\cmenfield\SyncFolderPM| | (] 70722 4 4 42032 7497 442 10004
072 5 1 18973 N4 m
72 & 1 67.89 1302 703
w2 7 1 27.1 544 290
o] v || F 02 8 1 1086 224 ne | 00|
R 9 1 rxn 09 a7
@ 7072 10 1 174 037 173
3) Check Curve Files to Us ¥ 70722 11 1 0.70 020 0812
[F] Z\Private\omerieid \SyncFoidenpi| | ) 70722 12 1 028 012 0.343 -
7] Z\Private\omenield SyncFolder\PM | | [V 70722 17 ! 6630.00 aR05 | 63 2 10+
072 13 1 2652.00 29445 2614 &
072 19 | 1060.30 15935 1080
R 2 | 42032 7445 439
< (] V| @02 2 1 18973 ;0. 16—
R 2 1 67.89 1291 697 14
R 2 1 27.1 510 272
s 5 R A 1 1086 209 1.0
4) Apply Filtering (optional) ] 4 1 P 126
Epccmeilines M2 2% 1 174 036 164
[ PlasmaSerum ;| R 27 1 070 018 0718 01-
| @ 70722 28 1 028 010 0284
072 3 1 6630.00 47635 7106
072 M 1 2652.00 29353 2601
¥l 70722 35 | 1060.30 1599 1085 amd
| | | | | | | |
W22 |36 ! 42432 BOG 4% 001 01 1 10 100 1000 10000 1E0S
Kit IDs w2 37 1 18973 3063 188 Knewn Cancentration
R 70722 3 1 67.89 12% 700
w2 1 27.1 534 285
) ) - Az a 4 e oh FrE Cuve R 5PL - Curve Weighting  1/¥2 -
57 poini(s) available < n | '
5) Enter Comments and Save  Comments

Figure 4-6: Build a Curve screen.

Export Kits Screen

From the Tools menu option, select Export Kits to display the screen for configuring an aggregated kit
export (see Figure 4-7). Use the filters and indicate the selected columns to prepare your kits export. Right
clicking on a checklist will give you the option to Select All or Select None. A list of exportable columns and
their data descriptions are in Table 4-3.

As you make selections, the number of matching records that will be in your export is displayed at the bot-
tom of the screen. Click the Export to Clipboard button for a tab delimited string or click the Export to CSV
button to create a spreadsheet compatible CSV file.
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Figure 4-7.
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: Export Kits screen.
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Column Description

AnalyteName

Biomarker name

AnalyteNumber

Analyte number in inlet layout (1 based) that produced the given
result.

AnalyzerDescription

A description stored on the Ella system as set by the user via the Run-
ner Menu (Settings-->Analyzer-->Description). The value will be
blank if not previously set by the user.

AnalyzerName

A unique system identifier stored on the Ella system by the OEM.

Background The background fluorescence intensity. This value is subtracted from
the signal value to obtain the RFU value.
Bufferld Factory Id of buffer included with the cartridge kit.

CalculatedConcentration

The concentration with dilution factor applied. A numerical value is
provided only if the value is within quantification limits.

CalculatedConcentrationPer-
centCV

%CV of the individual GNR calculated concentrations.

CalculatedConcentrationStatus

Provides concentration status such as IR (for in range) or OOR (for out
of range).

CalculatedConcentrationStdDev

Population or sample standard deviation of the individual GNR calcu-
lated concentrations (see IsSampleStdDev).

CaptureConcentration

Applies only to open cartridges. The concentration of the capture as
entered by the user.

CaptureName Applies only to open cartridges. The name of the capture as entered
by the user.

CartridgeComments Comments entered for the cartridge run by user.

Cartridgeld Factory Id of cartridge included with the cartridge kit.

ChannelNumber

Channel Number in a given cartridge inlet (1 based) that produced
the given result.

CurveCoefficientA

Calibration Curve Coefficient A - Estimated response at zero concen-
tration.

CurveCoefficientB

Calibration Curve Coefficient B - Slope factor.
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Column Description

CurveCoefficientC

Calibration Curve Coefficient C - Mid-range concentration (Cs).

CurveCoefficientD

Calibration Curve Coefficient D - Estimated response at infinite con-
centration.

CurveCoefficientG

Calibration Curve Coefficient G - Asymmetry factor.

DetectConcentration Applies only to open cartridges. The concentration of the detect as
entered by the user.

DetectName Applies only to open cartridges. The name of the detect as entered
by the user.

Diluent Id Factory Id of sample diluent included with the cartridge kit.

Diluted Concentration

The as measured concentration without a dilution factor applied. A
numerical value is provided only if the value is within quantification
limits.

DilutedConcentrationStatus

Provides concentration status such as IR (for in range) or OOR (for out
of range).

Dilution Factor

Multiplier used to compute calculated concentration from diluted
concentration (for example, 2 is a sample diluted in half).

Gnr1Background

The background fluorescence intensity for GNR 1.

GnriCalculatedConcentration

Concentration computed from the RFU of GNR 1 with dilution factor
applied.

GnriRFU The RFU of GNR 1(GNR 1 signal - GNR 1 background).

GnriSignal The GNR 1 fluorescence intensity. Subtracting GNR 1 background
from this yields GNR 1 RFU.

Gnr2Background The background fluorescence intensity for GNR 2.

Gnr2CalculatedConcentration

Concentration computed from the RFU of GNR 2 with dilution factor
applied.

Gnr2RFU The RFU of GNR 2 (GNR 2 signal - GNR 2 background).

Gnr2Signal The GNR 2 fluorescence intensity. Subtracting GNR 2 background
from this yields GNR 2 RFU.

Gnr3Background The background fluorescence intensity for GNR 3.
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Column Description

Gnr3CalculatedConcentration

Concentration computed from the RFU of GNR 3 with dilution factor
applied.

Gnr3RFU The RFU of GNR 3 (GNR 3 signal - GNR 3 background).

Gnr3Signal The GNR 3 fluorescence intensity. Subtracting GNR 3 background
from this yields GNR 3 RFU.

GnrCount Number of GNRs selected for the given result.

GnrFilter The GNR filter selection used for the given result: Concentration CV,

RFU CV, or None.

GnrFilterCVPercentThreshold

The GNR filtering threshold used for the given result.

InletComment

Comment for the given inlet entered by the user.

InletNumber The inlet number of the cartridge that produced the given result (1
based).

IsSampleStdDev True if the standard deviation is a sample standard deviation. False if
the standard deviation is a population standard deviation.

KitGuid Global Unique Identifier for the Kit.

Kitld Factory Id of kit. A kit is comprised of a cartridge, buffer, and sample

diluent.

KnownConcentration

The known concentration entered by the user. This value is used for
the percent recovery calculation.

KnownConcentrationEntere-
dUnits

Applies only to open cartridges. The concentration units entered by
the user.

LotNumber

The factory build lot comprised of N kits utilizing matching assay
components.

NonlimitedCalculatedConcen-
tration

The concentration with dilution factor applied. A numerical value is
provided regardless of quantification limits.

NonlimitedDilutedConcentra-
tion

The concentration without dilution factor applied. A numerical value
is provided regardless of quantification limits.

PercentRecovery

Calculated concentration divided by known concentration times 100.

RFU

The mean of the selected GNRs RFU values.
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Column Description

RFUPercentCV %CV of the individual GNR RFUs.

RFUStdDev Population or sample standard deviation of the individual GNR RFUs
(see IsSampleStdDev).

RunDate Local time and date the cartridge run took place.

RunUserName The user name of the account used to login to the OS (CFR mode dis-

abled) or login to Simple Plex software (CFR mode enabled).

SampleName The sample name entered by user.

SampleReplicate The instance number of a given unique combination of Sample
Name and Known Concentration within a Kit. Starting at Inlet 1 the
value will be 1. The next inlet with the same unique combination will
be 2 and so on. The value will be 0 if no Sample Name is provided.

SampleType The type of sample as entered by the user. (Control, Standard,
Unknown, Spike).

Signal The mean of the GNRs fluorescence intensity. Subtracting the back-
ground from this yields the RFU.

SpecimenTypes Intended Specimen types for assay, for example: plasma or serum.

Units Concentration Units, for example: pg/mL.

Table 4-3: Export column descriptions.

Apply Curves to Kits Screen

From the Tools menu option, select Apply Curves to Kits to display the screen for applying selected curves
to selected kits (see Figure 4-8). In the sub-panel use the checklists to check the kits to which you wish to
apply the curve you have selected. When you have completed your selections, click on the Apply to
Checked Samples button.

Clicking on the Apply to Checked Samples button will calculate concentrations from RFU results of each
checked sample point.

Click Update Kits to update the loaded kit results files with the applied curve changes.

Check Kits to Update

If data from multiple kits is available in Explorer they can be selected in the Check Kit to Update box.

User Guide for Ella



GUI Features page 69

Sample Points

Curves can now be applied to subsets of kit data by selecting individual data points to be included. Data
points from a kit can be included or excluded from the analysis by checking the check box at the far left of
the sample row.

Apply Filtering

The Apply Filtering options can be used to sort relevant subsets of data within a kit or multiple kits to be ana-
lyzed with a standard curve. Filtering options include:

- Specimen Types: Allows for filtering based on the type of biologic matrix being interrogated.

- Capture Name: For users working with a customizable cartridge format, filtering is available based
on the capture reagent identity.

- Capture Concentration: For users working with a customizable cartridge format, filtering is available
based on the capture reagent concentration.

- Detect Name: For users working with a customizable cartridge format, filtering is available based on
the detect reagent identity.

- Detect Concentration: For users working with a customizable cartridge format, filtering is available
based on the detect reagent concentration.

Apply Curves to Kits o
1) Select Analyte Check Al | | Uncheck Al Sample Points Reset Checked
Anaite [ILE v | o Inlet Sample Type ~ Sample Name Dilution Factor  RFLU Concentration Known Concentration  Specimen Typefs) ~ Species Type *
1 Standard STDKR1-1106 1 47258 £630.00 PlasmaSenm Human
2 Standard STD-KR-1-1106 1 29564 265200 PlasmaSerum Human
2) SokeciCUNG 3 Standard STD-KR-1-1106 1 15333 1060.80 PlasmaSerum Human
Curve File [Z\anala\unemﬁeld\ﬁynan\de(\FM Simple Plex"Core Teams'\Cham: v] 4 Standard STDKR-1-1108 1 7487 42432 PlasmaSeum Human
5 Standard STDKRI1106 1 3144 16973 FlasmaSenum Human
& Standard STDKRI1106 1 1202 £7.89 PlasmaSenm Human
3) Check Kits to Update 7 Standard STOKR-1105 1 544 2716 PlasmaSenm Human |z
oz 8 Standard STDKRA-1106 1 224 1086 PlasmaSenm Human
9 Standard STDKR-1106 1 093 44 PlasmaSenm Human
10 Standard STDKR--1106 1 037 174 PlasmaSenm Human
1 Standard STDKR--1106 1 020 07 PlasmaSenm Human
2 Standard STDKR--1106 1 012 028 PlasmaSenm Human
13 Cortrol Lac0828 1 771 210 PlasmaSenm Human
14 Cortrol HQC0-828 1 25282 1825.00 PlasmaSerum Human L4
4) Apply Filtering (optional) 15 Cortrl NGCD-31- 2 065 7.33 FlasmaSerum Human
P 16 Control NQC-0-33- 2 664 69.80 PlasmaSerum Human
Specimen Types = 17 Standard STDKR21105 1 47205 £630.00 PlasmaSenm Human
] PlasmaSerum | 18 Sanderd  STDKRZI106 1 29445 265200 PlsmaSenm  Human
3 19 Standard STDKR21106 1 159.35 1060.80 PlasmaSenm Human
L 20 Standard STDKR2-1106 1 7446 42432 PlasmaSenm Human
2 Standard STDKR2-1106 1 3016 16973 PlasmaSenm Human
2 Standard STDKR2-1106 1 12391 6789 PlasmaSenm Human
23 Standard STDKR2-1106 1 510 2716 PlasmaSenm Human
Capture Names 2 Standard STDKR21106 1 208 1036 PlasmaSenm Human
Standard STD-KR-2-1106 1 084 434 PlasmaSerum Human
Standard STD-KR-2-1106 1 036 174 PlasmaSerum Human
Standard STD-KR-2-1106 1 018 070 PlasmaSerum Human
=) Standard STDKR21106 1 0.10 028 FlasmaSenum Human
72 poini(s) available Cortral Lac0-828 1 763 4210 PlasmaSenum Human
Contrel HGC0-828 1 24520 1825.00 PlasmaSenm Human
5) Apply Selected Curve Contrel NGC-0-31- 2 068 733 PlasmaSenm Human
Control NOC-0-33- 2 610 £9.80 PlasmaSenm Human
Standzm r::"rn.wn.m ANA. 1 A?_R K RARIN NN Plazmz Sanim Himzn ; 2
Selected Curve Details
Specimen Typels): PlasmaSerum Units: pg/ml Comments 6) Update Kit Results Files

Figure 4-8: Apply Curves to Kits screen.
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Activating your Simple Plex Explorer Installation

Your Ella computer will be delivered with an activated installation of Simple Plex Explorer. If you opt to install

Simple Plex Explorer on additional PCs, you will be prompted to activate your installation prior to being able
to use it as shown in Figure 4-9.

% Simple Plex Explorer Product Activation *

Your copy of Simple Plex Explorer is inactive, please e-mail your activation request code to (click
link to use default mail client or copy/paste):

licensing@proteinsimple com

Activation Request Code |  Copy To Ciipboard
WNUR1pDU1csQ31WZWtDeVBsZXhFeHBsb3I1cg==

Activation Code | Paste From Clipboard

Figure 4-9: Explorer Product Activation dialog.

To activate your installation please e-mail licensing@proteinsimple.com the Activation Code Request as dis-
played in the dialog. You can either click the e-mail address link in the dialog to automatically copy the Acti-
vation Code Request into an e-mail and your default e-mail application or you can select and copy the
activation code request manually and then paste it into an e-mail to be sent to licensing@proteinsim-
ple.com.

A reply to your e-mail will contain your activation code, which you must copy and paste into the Activation
Code text box in the dialog as shown in Figure 4-10. Once you have entered your activation code clicking
the Activate button will validate the code, activate your installation, and display a confirmation dialog as
shown in Figure 4-11.
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% Simple Plex Explorer Product Activation bt

Your copy of Simple Plex Explorer is inactive, please e-mail your activation request code to (click
link to use default mail client or copy/paste):

licensing@proteinsimple com

Activation Request Code |  Copy To Ciipboard

WNUR1pDU1csQ31WZWtDeVBsZXhFeHBsb3I1cg==

Activation Code Paste From Clipboard

EFM8UmajVsFAQLTDECFckmV1BikmSBSk1vONQxRUgTPDrc
+wc IFYDIMADEEMZwghS5D8InLNz9WIn1RNUGET IxS5w==]

Valid Activation Code .

Figure 4-10: Explorer Product Activation dialog with an Activation Code entered.

(S

Activation Successful!

%

Figure 4-11: Explorer Product Activation confirmation dialog.
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Chapter 5:

Maintaining Ella

Chapter Overview
Introduction
Using the Simple Plex Runner Tools Menu
Preparing Ella for Shipment

Maintenance and Cleaning
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Introduction

This chapter describes maintenance and service tasks for Ella.

Using the Simple Plex Runner Tools Menu

The Tools menu (Figure 5-1) is used to conduct the instrument self-test, move the XY stage to predefined
locations (must be done with the clamp and lid closed), and export diagnostics system logs to a com-
pressed file for use by Technical Support.

|4] Simple Plex Runner - v.3.3.0.70

File  Settings | Tools | Help
Run 5elf Test

Inlet Assignmg Self Test History
Confirm Selec

- | Move To 4 Cartridge Load Position
Running Assa ohio Pocit

i it
Running Scan Export Logs b -
Kit Results Advanced . Objective Window Position

KitiD |

Lot Number

Figure 5-1: Simple Plex Runner Tools menu.

Ella Self-Test

The Ella Verification cartridge enables the system to perform a series of diagnostic tests that ensures the
instrument is running properly. The results are tabulated under the system log files. These results provide
valuable troubleshooting information to ProteinSimple personnel in the event system maintenance is
required. Accordingly, we advise that the verification cartridge is run once a week to create a running history
of system performance.

Your verification cartridge was provided in a storage box as shown in Figure 5-2. Whenever handling your
verification cartridge, wear gloves to avoid getting it dirty. The verification cartridge features a level indicator,
a surface to seal Ella's pneumatic interface, and an auto-fluorescing glass covered surface as an RFU refer-
ence.

To perform a self-test:
1. Remove the verification cartridge from the box.

2. From the Simple Plex Runner menu, click Tools > Run Self-Test and the Self-Test Dialog will appear.
Scan the verification cartridge barcode.

3. Remove the protective cover from the verification cartridge.
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NOTE: Do not discard the protective cover as it will be placed back on the verification cartridge when the
self-test is complete.

4. Place the verification cartridge in Ella.
5. Evaluate the level indicator:

a. Bubble outside of the outer lines indicates your bench and/or Ella must be leveled. It is recom-
mended that you level the bench rather than the Ella system. If bubble remains out of level, use the
adhesive backed cork pads (shims) found in the Verification Cartridge Box on Ella’s rubber feet as
required.

b. Bubble within and including the outer lines is acceptable.
6. Close the cartridge clamp and Ella’s lid.
7. Click the Start button to commence the Self-Test.
a. An Ella self-test can take up to 45 minutes.
b. While the test is running, progress and results are provided in the dialog.
¢. You can mouse over a progress bar for more details about that particular test.

d. Before the end of the self-test you will be prompted to remove the cartridge from the instrument
before the final step can be completed.

8. When the test completes, you will have the opportunity to save the test results to a CSV or PDF file for
historical or support purposes.

If the test fails please contact Technical Support.

This procedure is depicted in Figure 5-2 through Figure 5-12:
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Figure 5-2: Verification Cartridge box.

Figure 5-3: Verification Cartridge.
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Figure 5-5: Verification Cartridge in Ella.
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Level Indicator In Range

_Lé.\irel Indicator Out of'Ra'.'n'_Qg_e.

Figure 5-6: Verification Cartridge level indicator.

Figure 5-7: Clamping Verification Cartridge.
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| Analyzer Self Test [
Verification Cartridge Id: | 1000 Manufactured Date: | 09/19/2014

Firmware Compalibility |

Power Supply Voltage |

USB G ication Rate |

Motion Home ‘

Motion Upper Limits ‘

Motion Prescan |

Motion Position ‘

Motion Backlash ‘

DC Offset |

i Pneumatics ‘

Hot Plate Heater ‘

Laser Heater ‘

Focus Position |

Laser Position ‘

I Laser Power RFU ‘

|
|
|
|
|
|
|
|
Camera Frame Rate ‘ ‘
|
|
|
|
|
|
|
|

Pneumatics w/o Cartridge ‘

Scan barcode on Verification Cartridge, place into Ella and select Start to begin. i

Figure 5-8: Self-Test dialog.

| Anstyzer Self Test e —— |
Verification Cartridge Id: | 1000 Manufactured Date: | 09/19/2014

Firmwaro Compativity. [ Passed
Power Supply Vottage [ Passed
USB Communication Rate. I Possed
Motion Home L —

Motion Upper Limits ‘

Motion Prescan |

Motion Position ‘

Motion Backlash ‘

Camera Frame Rate ‘

DC Offset |

i Pneumatics ‘

Hot Plate Heater L —
Laser Heater L | —

Focus Position |

Laser Position ‘

I Laser Power RFU ‘

1
|
|
|
|
|
|
|

1

1
|
|
|
|

Pneumatics w/o Cartridge ‘

I

Figure 5-9: Self Test dialog - running.
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e esestssssssssssss————1
| Verificalion Cartridge Id- | 1000 Manufaclured Date: |09/19/2014 |
Frmwaro Compatioity I Fossod
Power Supply Votage I 25
| UsB Communication Rate R Passed

Please remove the verification cartridge, close the clamp and close the
door to complete the seff test.

Laser Position

Focus Positon. [ Fzssea

| Laser Power RFU

Pneumatics w/o Cartridge | |

Figure 5-10: Self Test dialog - remove cartridge dialog.

Self Te

Verification Cartridge I1d: | 1000 Manufactured Date: |09/19/2014
Fimware Compatibiity | Passed
Power Supply Voltage | Pessed
USB Communication Rate. [ Possed
Motion Home. | Passed
Motion Upper Limits. [ Passed
Motion Prescan. [ Pessed
Motion Position. [ Possed
Motion Backiash [ Passed
Camera Frame Rate. | Passed
DC Offset. [ Passed
| Proumatics I Possed
Hot Plate Heator [ Passed
Lasor Heator | Fassed
Focus Position. I Passed
' Lasor Position. | Possed
| Laser Power RFU | Passed
Preumatics wio Cartridge. [ Fassed

|

Figure 5-11: Self Test dialog - completed.

User Guide for Ella

page 79



Using the Simple Plex Runner Tools Menu page 80

Simple Plex Self Test Report

Analyzer: Ella-17030138

Test Date: 05/01/2017 10:19 AM

Overall Result: Passed

Cartridge ID: 138 (Focus Offset: -200, Expected RFU: 1704)
Application Name: Simple Plex Runner

Application Version: 3.3.0.36

Firmware Version: 1.0.0

Test Results

Test Result Data Comments
Firmware Compatibility | Passed
Power Supply Voltage | Passed | 5V PS =4.948381V (Expected: 4.5 t0 5.5), 6V
PS =5.961958V (Expected: 5.5 to 6.5), 24V PS

= 24.25606V (Expected: 23.5 to 24.5)
USB Communication Passed | Average Time Per Command = 0.35259147ms
Rate (Expected: <= 0.7)
Motion Home Passed

Motion Upper Limits Passed X Encoder Delta = 1 (Expected: <= 20), Y
Encoder Delta = 3 (Expected: <= 20), Z

Figure 5-12: Self-Test results file snippet.

Using the Move To Commands in the Simple Plex Runner Software Menu

Objective Window Position

The Tools > Move To > Objective Window Position command is provided to move to the correct position
for removing or installing the objective window that is threaded into the heater plate.

Cartridge Load Position

The Tools > Move To > Cartridge Load Position command is provided to return to the load position if you
have previously moved to the objective window position or ship position. It is also provided in the highly
unlikely event that the instrument does not return the stage to the load position. If this occurs, please con-
tact ProteinSimple Technical Support.

Ship Position

The Tools > Move To > Ship Position command is provided in the event that Ella is to be packed for ship-
ment.
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Preparing Ella for Shipment

To prepare Ella for shipment:

1. Close the clamp and the lid.

2. Click Tools > Move To > Ship Position on the Simple Plex Runner menui.
3. Wait for the Moving to shipping position pop-up dialog to close.

4. Shut Ella down:

a. Close Simple Plex Runner either by clicking File > Exit from the menu or Close (X) in the upper-right
corner of the application window.

b. Shut down Ella's computer.

c. Turn Ella off by pressing the power switch on the back panel.

Exporting System Logs

Clicking Tools > Export Logs is used to export diagnostics information to a compressed zip file if requested
to do so by Technical Support.

Maintenance and Cleaning

Ella requires minimal preventative maintenance. However, when performing periodic inspections of the sys-
tem, take note of any damage to Ella’s enclosure or the insulation of associated cables. If the enclosure dam-
age indicates that protection of the electronics from moisture intrusion or laser light is compromised or that
compromise is imminent, or if the cable damage suggests that cable electrical shorts or opens are immi-
nent, then take the appropriate corrective action depending on the situation — up to and including
removal of the product from service until repairs have been performed. Contact Customer Support for infor-
mation regarding repairs and spare parts.

Fan Filter Cleaning and Maintenance

Ella must always receive adequate ventilation for cooling. Proper cooling is required for Ella to meet specifi-
cations, and to avoid overheating. Periodic instrument maintenance should include inspection and cleaning
of the fan filter every six months.

To clean the filter:
1. Remove the fan guard and fan filter.
2. Vacuum the fan filter to clean it.

3. If necessary, replace worn-out or damaged fan filters (PN 541401).
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4. Reinstall the fan filter and fan guard.

External Surface Cleaning

Turn off and unplug Ella prior to cleaning. If required, wipe down all of Ella’s external surfaces using a damp
cloth with a small amount of water or a mild detergent.

Cartridge Nest and Objective Window Cleaning

Cartridge Nest. If required, Ella’s cartridge nest can be cleaned using a lint-free wipe dampen with ethanol.
When cleaning the nest, care should be taken not to contaminate the objective window.

Objective Window. Care should be taken to ensure the objective window is clean. If cleaning is required,
use a clean, lint-free wipe dampened with ethanol. Multiple one-time use wipes are recommended to
ensure the objective window is cleaned (streak-free), see Figure 5-13.

Objective Window

Cartridge Nest

Figure 5-13: Cartridge Nest and Objective Window.
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Chapter 6:

Simple Plex 21 CFR Part 11
Compliance

Chapter Overview
Overview
Activating 21 CFR Part 11 Support for Simple Plex Runner
Enabling 21 CFR Part 11 Mode for Simple Plex Runner
Administering User Groups
Logging In, Logging Out and Locking
Saving Changes

Viewing Change History
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Overview

The Simple Plex software 21 CFR Part 11 features can be used to help satisfy regulatory data security require-
ments when using Ella. When the 21 CFR Part 11 feature is activated and enabled:

Windows user accounts (located either on the local PC or on a Windows Domain Active Directory) are
utilized for user validation.

Users are required to login to use Simple Plex Runner.

A run will produce an encrypted data file (ECYDAT) that is electronically signed by the currently
logged in user (see Table 6-1).

Every ECYDAT file contains the file's change history. Any time changes are made to the data in an ECY-
DAT file, a valid user must sign the changes prior to saving.

Reviewing and editing ECYDAT files with Simple Plex Explorer requires a user login, and a valid user
must sign any changes prior to saving.

Simple Plex Explorer does not require additional activation to work with ECYDAT files.

When Simple Plex Explorer is used to create calibration curves from ECYDAT files, an encrypted curve
file (ECYCURV) is produced that is signed, saved and potentially utilized to compute concentrations in
ECYDAT files.

Unsecured files (CYDAT/CYCURV) may not be used to create ECYCURYV files or compute concentra-
tions in ECYDAT files.
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Feature Simple Plex File Extension

CYDAT CYCURV ECYDAT ECYCURV
Encrypted No No Yes Yes
Editable Yes No Yes No
Tracks changes No N/A Yes N/A
Electronically Signed No No Yes Yes

Table 6-1: Simple Plex file extensions features summary.

Activating 21 CFR Part 11 Support for Simple Plex Runner

21 CFR Part 11 support for Simple Plex Runner is a purchased add-on that must be activated prior to use. To

activate the 21 CFR Part 11 support:

1. Click Help > Activate 21 CFR Part 11 Support... (Figure 6-1).
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[ Simple Plex Runne:

File  Settings Tools | Help

Inlet Assignments About
Confirm Selections

Activate 21 CFR Part 11 Support... l

Figure 6-1: Help menu.
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NOTES:

If the Activate 21 CFR Part 11 Support... menu option is not present, your installation has already been

activated.

If you ordered your Ella system with 21 CFR Part 11 support, the system will be activated prior to being

shipped.

The Activation dialog window will display (Figure 6-2):

ﬁ Simple Plex Runner 21 CFR Part 11 Support Activation e

21 CFR Part 11 support for your copy of Simple Plex Runner is inactive, please e-mail your
activation request code to (click link to use default mail client or copy/paste):

licensing@proteinsimple com

Activation Request Code |  Copy To Ciipboard
W3NUR1pDU1csQ31WZWtDeVBsZXhSdWSuZXIyMUNGU1BhcnQxMQ==

Activation Code Paste From Clipboard

WCVtgZTSIiaulBZwT295LN3Wkj5q0Br17ka7ksvfey04ZTQXmpXq32KvecbTFpPmWPSthz96cp7
GrDFRyZrxErfA==

Valid Activation Code .

Figure 6-2: Figure 2 - Runner: 21 CFR Part 11 Support Activation Dialog

2. Click the email link to e-mail the Activation Request Code to licensing@proteinsimple.com. You will
receive a reply e-mail within 24 hours with your Activation Code.
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3. Copy your activation code into the Activation Code text box, then click the Activate button.

Enabling 21 CFR Part 11 Mode for Simple Plex Runner

Upon activation, the 21 CFR Part 11 Mode will be enabled by default. It is possible to have an active license
and opt to disable the 21 CFR Part 11 Mode. To enable/disable the 21 CFR Part 11 Mode:

1. Click Settings > Application.
The Settings Dialog will display (Figure 6-3):

Application Settings @
541 |
4 21CFR Part 11 -
Use21CFRPart11Mode False
AutoLockInactivityMinutes 10
LogoutWhenDone True
AllowOutput File PathChange True
4 Data

Figure 6-3: Simple Plex Runner Settings dialog.

2. Toggle Use21CFRPart11Mode to True and click Save.

3. Amessage will display to restart the Runner application in order to start using the 21 CFR Part 11 Mode
(Figure 6-4).

Simple Plex Runner e

:' 21 CFR Part 11 mode will not start until the application is restarted.

Figure 6-4: Restart application to start using 21 CFR Part 11 Mode.

4. Restart the Simple Plex Runner application. You will be required to login in order to use the application
once it relaunches.

Administering User Groups

If you are not familiar with managing user accounts and security groups, it is recommended that you con-
tact an IT representative for assistance.
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When 21 CFR Part 11 Mode is enabled, both Simple Plex Runner and Explorer will perform user account vali-
dation via the Local PC and/or Windows Domain Active Directory Security Groups. In both cases, two specif-
ically named Security Groups will be referred to as shown in Table 6-2.

Security Group Permission

Simple Plex Admins Members in this group can fully operate Simple Plex software in 21 CFR Part
11 Mode and can change 21 CFR Part 11-related settings.

Simple Plex Users Members in this group can fully operate Simple Plex software in 21 CFR Part
11 Mode, but are prevented from changing 21 CFR Part 11-related settings.

Table 6-2: Security groups.

These two Security Groups are created for you during the Simple Plex Runner or Explorer software installa-
tion. In order to perform the following operations, you will need to be a local system administrator.

NOTE: The default login (User Id: Ella and Password: Ella) is a local system administrator.

If you wish to use the Local PC security groups: simply add users to one of the groups to permit
the users to use the Simple Plex applications.

If you wish to use a Windows Domain Active Directory Security Group: you will need to contact
your IT representative and request that they create the specifically named groups in your active direc-
tory, and then add users accordingly.

If the user name entered does not specify a Local PC or domain: to validate users, the Simple Plex
software first attempts to validate user credentials and security group membership on the Local PC. If
this validation fails, the Simple Plex software will attempt to use the domain (if the PC is a member) to
validate user credentials and security group membership.

NOTE: As part of the 21 CFR Part 11 regulation, the user account must have a Full Name associated with it
in order to be considered valid.

Providing specific detailed instructions for creating security groups and adding users to these groups is
beyond the scope of this manual. A brief 'how-to' for Local PC setup is provided in Appendix B, “Managing
Users and Groups for 21 CFR Part 11 Support”. If you do not have an IT representative to assist, you can contact
ProteinSimple Technical Support for assistance with Local PC configuration.
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Logging In, Logging Out and Locking

When 21 CFR Part 11 Mode is enabled, you will be required to log in to Simple Plex Runner in order to utilize
the system (Figure 6-5). You will also be required to log in to Simple Plex Explorer the first time you load

either an ECYDAT or an ECYCURYV file for review or modification (Figure 6-6).

111 Simple Plex Runner - v3.0052 = |

File Settings Tools Help

Running Scan
Kit Results

proteinsyinslls

a bietechne brand

User name: |

Password:

=
Tooellogn . proeng
[INewkit Login proteinSiuiE
[[ nlet Assignments
Confirm Selections
Running Assay

Notlogged in

21 CFR Part 11 Mode Enabled |

Figure 6-5: Simple Plex Runner log in.

User name: DemoUser

Password: coccocco|

Lwn ] [

Figure 6-6: Simple Plex Explorer log in.

You may also opt to log in to Simple Plex Explorer prior to loading encrypted files by selecting File > Log in

(Figure 6-7).
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File | View Tools

Settings

Load Kit{s)
Load Curve(s)

Recent Kit Results

Recent Curves

Legin

Exit Ctrl+Q

Help

3

3

3

L-10. TNF=a

Kit I1d: 11247 - Cartridge Id

Figure 6-7: Logging in to Simple Plex Explorer in the File menu.
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In order to successfully log in, your user account must be a member of either the Simple Plex Users or Simple
Plex Admins security groups on the Local PC or your Windows Domain Active Directory. Once you success-

fully log in, you may proceed with utilizing the application to perform tasks.

You can logout of Simple Plex Runner by clicking the Log out button on the New Kit screen (Figure 6-8).

(14 Simple Plex Runner - v.3.5.06 == = ]
File Seitings Tools Help Demo Mode Enabled
PR New Kit el =lylsimple
Inlet Assignments 1) Scan Kit Barcode
Confirm Selections
Running Assay KilIy e
Running Scan
Kit Results Lot Number ‘ ‘
Expiration Date | |
Cartridge Type ‘
Analytes
Species Type ‘ ‘
2) Scan Cartridge Barcode
Cartridge ID
3) Confirm or Change Output File Name
Kit Results File Name [ Change.
Current User: Colin Merrifield (CELLBIOSCIENCES\ cmerrifield) 21 CFR Part 11 Mode Enabled _:

Figure 6-8: Simple Plex Runner New Kit screen.

Additionally, if the LogoutWhenDone setting is set to True (the default setting, see Figure 4) clicking Done
in the Simple Plex Runner Kit Results screen will also log the current user out (Figure 6-9).
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124 Simple Plex Runner - v3.4042 [=/@] % |
File Setings Tools Help Demo Mode Enabled

Inlet Assignments | it 1d- 1000 - Cartridge Id: 20357
Confimn Selections

Nowki Kit Results gsimple )}

Running Assay Analytes: IFNg, IL-2ra, IL-6, TNF-a
Runmni Scan Comments
IFNg (no LOQ) 1L-2ra (no LOQ) 1.6 (noLOQ) “TNF-a (no LOQ)
Inlet | Sample GNRs Mean ... RFU Mean Conc.... Conc. GNRs Mean ... RFU Mean Conc.... Conc. GNRs Mean ... RFU Mean Conc.... Conc. GNRs  Mean ... RFU Mean Conc.... Conc.
I 5 v om 3 v 05 oss 5 v ae 1w 5 v oue 1
2 5 veus o 5 v um 1w 5 -2 1% 5 v ue e
B 5 v 1 3 v 26t 03 5 v 2 1: 5 v uw 2w
4 5 v om0 5 v ous o 3w 1se 5 v ous 1w
s 5 v mz 5 v uns am 5 v 20 0@ 5 v ue om
s 3 v om0 5 v 2 5 -2 o 5 v ues 1
7 5 v 7m0 5w L0 1 5 v am 1w 5 v 20
s 5 v ma o 5 - oue 208 s s 30 5 v me 12
B 5 v s 5 vun o 5 v mm o 5 v um 1z
n 5 v ms om 5 vun i s an e 5 v ua s
1 5 v am s s s e 5 -2 om 5w oma 1
[ 5 v ms os 5 v s om 5 v amy sst 5 v us o
5 3 v % oes 5 v w1 5 v s o 3 v s ses
1 5 v 01 5 v oua 2 5 v me s 5 v s os
f5 5 v m0s om0 5 v ue 2s BRE 5 v uy e
A 5 v 7mes o 5 v us 10 s v am oy 5 v um ost

Fher GNRs By: [RFUCY <) Treshod (20 [100 (2] < Addiona O Boot 4

feld (USSI0 4CBG1G2 L cmmtato | K 1000 21 CERPar 1 M Erabied

e

Figure 6-9: Simple Plex Runner Kit Results screen.

You can log out of Simple Plex Explorer by selecting File> Log out (Figure 6-10).

View Tools Help

Settings 3
Load Kit{s) L-10. TNF<
Load Curve(s) L-10, TNF=

Recent Kit Results  »

Recent Curves 3
Log out
Lock

Exit Ctrl+Q

rndge Id

Figure 6-10: Logging out or locking Simple Plex Explorer in the File menu.

Once you have successfully logged in, you have the option to lock the application thereby requiring that
you or another valid user (via the Switch User button) must unlock the application with valid user creden-
tials. To lock either Simple Plex Runner or Explorer, you can either click the Lock button in the lower left cor-
ner of the application window, or click File > Lock (Figure 6-10and Figure 6-11). Locking/unlocking will not
interrupt any ongoing operations.
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Settings  Tools
Lock

Help

Exit  Ctrl+Q

Confirm Selections
Running Assay
Running Scan
Kit Results

Figure 6-11: Locking Simple Plex Runner in the File menu.

When locked, the application will show the Locked screen (Figure 6-12 and Figure 6-13).
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NOTE: Simple Plex Runner will continue to display operations status and progress in the Locked screen and

at the bottom of the window.

[|1nlet Assignments
[|Confirm Selections

Running Scan
Kit Results

= 8 CYVEK-DT16\DemoUser

Password:

Current UsesDermo User (CYVEK-DTL6\DemoUise) | K16 1000 | [ R

Figure 6-12: Simple Plex Runner Locked screen.
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Simple Plex Explorer (Locked)

slgelSilplsimple

IELTg =T B CYVEK-DT16\DemoUser

Password:

Curent User: Do User CYVEK DT16\DemoUsr)| N KisLoaded | No Curves Loaded 21 CFRPart 1 Mode nsbled_|

Figure 6-13: Simple Plex Explorer — Locked screen.

Simple Plex Runner and Explorer will automatically lock the application after a configurable period of time
called AutoLocklInactivityMinutes that is set to 10 minutes by default. Members of the Simple Plex Admins
are permitted to change the settings (Figure 6-14, and Figure 6-15). Please note that in most cases, Simple
Plex Runner will be locked at the completion of a run.

File | View Tools Help

| Settings 3 Application .
pted Fi

Load Kit(s) = T

] Load Curve(s) 21 CFR Part11 c

Recent Kit Results  »

Recent Curves 3
Log out

Lock

Exit Ctrl+Q

Kit Id: 11742 - Carindge Id: 13302

Figure 6-14: Simple Plex Explorer Settings menu.
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21 CFR Part 11 Settings
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4 21CFR Part 11
AutoLockInactivityMinutes 10

Figure 6-15: Simple Plex Explorer Settings dialog.

Saving Changes

In Simple Plex Runner and Explorer, upon choosing to save your changes you will be prompted for an elec-
tronic signature in the form of a valid user name and password, and a reason for the change(s) as shown in

Figure 6-16.

-
Save Kit Results

- - M‘

Password: eseesese

User name: CYVEK-DT16\DemoUser

Show Cumrent Changes

Reason \ Comments: Removed a GNR, Inlet 1, IL—‘Ib|

l Save

| e

L

Figure 6-16: Save Kit Results dialog — e-signature.

Clicking the Show Current Changes button allows you to review the changes you are signing or saving

(Figure 6-17).
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F - “ - B
Save Kit Results - — - - - M
Parameter Old Value New Value
Manual GMR Selections for Inlet 1, Analyte IL-1b 1.2 3zet by fitter) 13
] 1 ¢
l Save l l Cancel l

h

Figure 6-17: Save Kit Results — current changes.

Itis also possible to add a revision without changes for the purposes of simply adding a note.

Viewing Change History
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The change history contained in an ECYDAT file may be viewed in detail by clicking the Change History
radio button located on the upper right side of the Kit Results Panel in Simple Plex Runner or Explorer. Addi-
tionally, when a kit is saved to a PDF all change history is included. On the Change History panel the details
of any particular revision may be viewed by selecting the revision in the upper list of the Change History

panel (Figure 6-18 and Figure 6-19).
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Running Assay Analytes: IL-1b, IL-6, IL-10, TNF-a

Runmni Scan Comments: comments concerning the run here

153 Simple Plex Runner -v30052 —————— — - - — . g =)
Fle Setings Toos Help Demo Mods Encbled
T ]
Nowkit Kit Results pr S|mple
Inlet Assignments | it 19: 1000 - Cartridge Id: 9427 i

Confitm Selections

Revison  Author Date Reason \ Commerts Revison ID

[ Demo User (CYVEK-DT16\Demolser)  1/7/2016 4:28:16 PM Created e6o851-2116-4057-9636.0955.
Change Detalls

Parameter 0id Value New Value

Kitresults saved to Kit001000(1).ecvdatin CAU:

Curent User Do User (CWVEK DT16\DemoUser) K 000

21 CFR Part 11 Mode Enabled |

Figure 6-18: Simple Plex Runner Kit Results screen — change history

Fie View Tools Help

Kt Id Ansltes Encrypted _ Filename

Run Date User
1000 IL-1b, 16, 1110, TNFa Yes c

05/05/20159...  Demo User (CY..,

oo iRt

i

‘Specimen Typets) Species Type Lot Numper | Selected Kt

PlasmaSeun Human 2%

Kit 1d: 1000 - Cartridge Id: 9427
Analytes: IL-b, IL-6, IL-10, TNF-a

Inet Assignmerts

Calbration Curves
Comments: Change History
Revison  Author Date

Resuts Summary.

Reason \ Commerts

Demo User (CYVEK-DT16\Demolser) 56/5/2015 3:42:29 AM

Revision ID

Removed a GNR. et . IL-Tb

[ Demo User (CYVEK-DT16\Demolser) 5/5/2015 9:26:47 AM Created TolicsE 4.
Change Detaiis

Parameter Old Value New Value Descpton

Manual GNR Selections for it 1. Anaite IL-1b 123set by fter) 13

“Automatic GNR Selectonsfor et 1, Analte IL-Tb" manu.

Carent Usr Do User (CWEK-DTI6\Demaler | 1 Kis Losdd | No Corves Loaded

21 CFR Part 11 Mode Enabled

Figure 6-19: Simple Plex Explorer Kit Results screen — change history
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Appendix A:

EC Declaration of Conformity
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Appendix A: EC Declaration of Conformity

DECLARATION OF CONFORMITY I

(According to ISO/IEC GUIDE 22 and EN 45014)

Manufacturer’s Name: ProteinSimple (a Bio-Techne brand)
Manufacturer’s Address: 3001 Orchard Parkway

San Jose, CA 95134
U.S.A.

DECLARES, THAT THE PRODUCT

Product Name: Protein analysis equipment
Model Number: Ella

CONFORMS TO THE FOLLOWING EUROPEAN DIRECTIVES
Low Voltage Directive: 2006/95/EC

EMC Directive: 2004/108/EC
RoHS Directive: 2011/65/EU

Supplementary Information:

Safety: IEC/EN 61010-1:2010; CAN/CSA-C22.2 No. 61010-1:2012
EMC: IEC/EN 61326-1:2006
Laser Safety: IEC/EN 60825-1:2014

Year CE Mark Affixed: 2015

I, the undersigned, hereby declare that the equipment specified above conforms to the above
Directives and Standards.

7
Place: Wallingford, CT Signature: W

Date: 08-Sep-2017 Full Name: Henry Couture I

Position:  Director of Quality

D45-0001-001 Rev C

M
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Managing Users and Groups

The following is a guide to managing Local PC Users and Groups. You must be a local administrator in order
to perform any of the tasks described herein. This guide does not cover managing users or groups for a local
area network.

To manage your Local PC users and groups click on the Windows Start button, right click on Computer, and
then click Manage (Figure B-1). Doing so will display the Computer Management window (Figure B-2).

“ E MNotepad
“ Adobe Reader XI 3
14 simple Plex Runner Documents
ig Simple Plex Explorer 3
Camtasia Studic 8 3
BarTender Computer
@ Control Panel 3
@l Paint 3
[ )etBrains PyCharm Community Edi...

P, Send to OneNote 2013

Recent ltems

Open
Network '@' Manage

TortoiseSVN 3

Map network drive...
Disconnect network drive...

Show on Desktop

Rename

Properties

¥ All Programs

Figure B-1: Accessing the Computer Management in Windowys.
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-
A Computer Management

=)

File Action Wiew Help

> (%) Performance
5 Device Manager
4 55 storage

& performance Log Users
& Offer Remote Assistance Helpe
% Network Configuration Operat

B Event Log Readers

Rename

Properties

Members of this group can read event logs from local machine

his group may schedule logging of performance counters,...
his group can offer Remote Assistance to the users of this ...
his group can have some administrative privileges to man...

m

1= Disk Management #1s_1usks Help p used by Internet Information Services.
Services and Applications 2= HelpLibraryUpdaters
P Guests Guests have the same access as members of the Users group by default,... B

S gumputer Management (Local) || pame Description * || Actions
4 [ft System Tools B simple Plex Users Members in this group can fully operate Simple Plex software in 21 CFR ... Groups -
> (D Task Scheduler L~ Simple Plex Admins he e s group can fully operate Simple Plex software in 21 CFR .. More Actions b
> 2] Event Viewer Add to Group...
+ Shared Fold 2% Replicator eplication in a domain i
b ared Folders -
. i Local Users and Groups B Remote Desktop Users All Tasks his group are granted the right to logon remotely Simple Plex Adm... &
| Users B Power Users are included for backwards compatibility and possess limit... More Actions b
| Groups & Performance Monitor Users Delete his group can access performance counter data locally an...

& Distributed COM Users Members are allowed to launch, activate and use Distributed COM obje... -

Figure B-2: Computer Management.

Once the Computer Management window is open, expand Local Users and Groups under System Tools.
To add users, select the Users folder from the tree on the left of the window. Doing so will display a list of
local users in the center section of the Computer Management window. Right click on the list of local users
and select New User... (Figure B-3). A New User dialog will display (Figure B-4). Complete the dialog and
click Create to add a new user.

File Action View Help

L Al G Ry
& Computer Management (Local) || Name Full Name Description Actions
< it SY“:MJ:i:‘d ‘ & $BarTender_Security BarTender Security User  BarTender Security Center standar... Users -
> (D Task Scheduler & SPrinter MaestroS Printer Maestro Remote .. Account for unprivileged accesst... ;
> [ Event Viewer More Actions b
41 Shared Folders # Administrator Built-in account for administering...
>
ko
4 & Local Users and Groups || = <t _
= Users A yvekadmin CyVek Admin
=] Groups & Demolser Demo User
» (@ Performance #, Guest Built-in account for guest access t...
5| Device Manager
4[5 Storage New User
(=7 Disk Management
> Fs Services and Applications Refresh
Export List...
View >
Arrange leons v
Line up Ieans
Help

Figure B-3: Computer Management — new user.
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-
New User

User name:
Full name:

Description:

DemoUser

Demo User

Password:

Confirm password:

[ User must change password at next logan
[ User cannat change password

[ Password never expires

[ Accourt is disabled

[ Create ][ Close

Figure B-4: New User dialog.

To manage groups, select the Groups folder from the tree on the left of the Computer Management win-
dow. Doing so will display a list of local groups in the center section of the Computer Management window.
To add a group, select and right click on a specific group and click Add to Group... to manage the group
membership (Figure B-5). Clicking Add to Group... will display the Group Properties dialog which can be
used to add or remove members to and from the selected group (Figure B-6).

-
A Computer Management

File Action View Help

e | rEXE= HBE

;é-- Computer Management (Local)
a {f} System Tools

> () Task Scheduler

» @] Event Viewer

> (%) Performance
i Device Manager
4 23 Storage
=f Disk Management
> F Services and Applications

MName
B Simple Plex Users
- Simple Plex Admins

Description

» 4| Shared Folders %REP““W G ey eplication in a demain

4 8 Local Users and Groups ¥ Remote Desktop Users Al Tasks his group are granted the right to logon remotely
| Users B Power Users sre included for backwards compatibility and possess limit...
| Groups %‘PE#UVmEH(EMDﬂItDI’ Users Delete his group can access perfformance counter data locally an...

B performance Log Users

B Offer Remote Assistance Helpe
P Network Configuration Operat
TS USRS

& HelpLibraryUpdaters

Rename
Properties

Help p used by Internet Information Services.

Members in this group can fully operate Simple Plex software in 21 CFR ...
RS LSASSS his group can fully operate Simple Plex software in 21 CFR ...

his group may schedule logging of performance counters, ...
his group can offer Remote Assistance to the users of this ...

his group can have some administrative privileges to man...

| Simple Plex Adm... «

m

Actions

Groups -
Mare Actions  »

Mare Actions  »

B Guests
¥ Event Log Readers
2 Distributed COM Users

Guests have the same access as members of the Users group by default,...
Members of this group can read event logs from local machine
Members are allowed to launch, activate and use Distributed COM obje... o

Figure B-5: Computer Management —groups.
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Figure B-6: Group properties.
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-
Simple Plex Admins Properties

General

%]‘ Simple Plex Admins
Description: Members in this group can fully operate Simple Plex f
software in 21 CFR Part 11 mode and can change 21
| |
Members:
W A oyvekAdmin '
A Demollser U
i |
i H
i N
i N
l
H
|
Changes to a user's group membership |
fl Remaove are not effective until the next time the f
= user logs on.
| [ ok ][ Ccancel Aoply Hep | ||

Click the Add button on the Group Properties dialog. The Select Users dialog will display (Figure B-7). Enter
the names of the users you wish to add and click Check Names. You may need to change the location to
search by clicking the Locations... button. Clicking the Locations... button will display the Locations dia-
log (Figure B-8) from which you can specify what location to search for the users names entered in the Select
Users dialog. When clicking the Check Names button results in the entered user being resolved and under-
lined, click the OK button to add the users to the Group.

Figure B-7: Select users dialog.
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d k]
Locations @Iﬂ

Select the location you want to search.

Location:

L CYVEK-DT16
Ertire Directory
(-3 cyvek local

[ ok ][ Ccancel

Figure B-8: Locations dialog.

Using the Computer Management window is how you add local users, local groups, and configure the
membership of the local groups. It should be noted that local groups may contain domain user accounts
and/or domain security groups.

Finally it is important to note that in order for a user to utilize the Simple Plex software when 21 CFR Part 11
Mode is enabled, the user must be a member of either the Simple Plex Users or Simple Plex Admins group
located locally and/or in the Windows Domain Active Directory.
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Overview

This section shows you how to import kit run data from your Simple Plex software into Thermo-Fisher’s Wat-
son LIMS system if you have one. To do this, you'll first need to create Sequence files (SEQ) in Watson using
the Generic Raw Data Interface (one file for each analyte). These Sequence files can then be used in Simple
Plex Runner or Simple Plex Explorer to import sample names and dilution factors into your Kit Results file
(CYDAT). Once the run is complete, the Sequence files can then be updated with the relative fluorescent
units (RFU) from each GNR. The completed Sequence files are then used to import the run data into Watson.

Tips for Configuring Watson LIMS Master Assay
Set assay type to RIA
Set Instrument Type to Ella if available.
An Ella Instrument Type can be added by your Watson LIMS administrator
Select any Instrument Type if Ella is not available
Set data interface to Generic-raw data

Set 3 replicates per sample.

Sample Entry Requirements for Watson LIMS

Sample identities for standards, unknowns and QCs must be entered in the specific formats detailed below.
Standards information can be requested for some or all concentration levels and should be at the beginning
of the sequence. Your Certificate of Analysis (CoA) provides the information necessary (such as concentra-
tion and ID). Unknowns and QCs should follow standards in order by cartridge inlet number.

Details for each Sample Type

Standards
Sample identity must be in the following format:

[.ISTD.#
[..]=any text
STD.# is the concentration level ID
STD.1 is first highest concentration
STD.2 is next highest concentration, etc.
These are available on CoA in high to low concentration order
Examples:
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Test_STD.1
Test_STD.2

Not all standard concentration levels need to be requested. For example, if the highest concentration
is to be left out of the curve calculation then the first entry for Standards could be Test_STD.2.

Number of replicates must be set to a number less than or equal to the number of replicates avail-
able.

Total number of replicates available is on the CoA (as column 'n"). For example, n=4 means there
are 4 replicates (i.e. data points) available for request.

Dilution factor must be specified.

Concentration information is available on the CoA.

Unknowns
Sample identity must be in the following format:
[.]
[.] =any text
Example: Test_Sample_A
Number of replicates must be 3 (1 for each GNR).

Dilution factor must be specified.

QCs
Sample identity must be in the following format:
[.]
[..]=any text
Example: Test_HQC.1
Number of replicates must be 3 (1 for each GNR).

Dilution factor must be specified.

Generate Sequence Files in Watson LIMS using Generic Raw Data
Interface

Please refer to your Watson LIMS User Manual (currently under Appendix A - Raw Data Interface) on how to
export your sample information for a run as Sequence files using the Generic Raw Data Interface. You must
create one Sequence file for each analyte.
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Example of Sequence file exported from Watson LIMS

Appendix C: Watson LIMS Interface Guide

11 Test_STD.1 11 put the File | putthe Assay IL.-6 put the Raw put the Retention
Name Date/Time Data Time

12Test_STD.12 1 put the File | putthe Assay IL-6 put the Raw put the Retention
Name Date/Time Data Time

13Test_STD.131 put the File | putthe Assay IL-6 put the Raw put the Retention
Name Date/Time Data Time

1 4 Test_Sample_A_2 put the File | putthe Assay IL.-6 put the Raw put the Retention
Name Date/Time Data Time

1 5 Test_Sample_A_2 put the File | putthe Assay IL.-6 put the Raw put the Retention
Name Date/Time Data Time

16 Test_Sample_A_2 put the File | putthe Assay IL-6 put the Raw put the Retention
Name Date/Time Data Time

17 Test_HQC1 12 put the File | putthe Assay IL.-6 put the Raw put the Retention
Name Date/Time Data Time

18 Test_HQC.122 put the File | putthe Assay IL.-6 put the Raw put the Retention
Name Date/Time Data Time

19 Test_HQC.132 put the File | putthe Assay IL-6 put the Raw put the Retention
Name Date/Time Data Time

NOTE: When the Sequence file is exported from Watson LIMS, additional information is added to the sam-
ple identity to create the full sample name entry in the first column. Run number and a sequence number
are inserted in front. Replicate number (for standards and QCs) and dilution factor are appended to the

end.

IMPORTANT

Keep your sample identity names relatively short (less than 60 characters). The combined length of

run number, sequence number, sample identity, replicate number and dilution factor should not be
longer than 80 characters. At the time of this writing, the current version Watson LIMS truncates any
text beyond 80 characters. This causes sample identities to be shortened arbitrarily, and you will not

be able to import your run data into Watson.
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Importing Watson LIMS Sequence Files into Simple Plex Software

Once you've created your Sequence files in Watson LIMS, you'll need to import them into your Kit Results file.
To do this in Simple Plex Runner or Simple Plex Explorer:

1. Go to the Inlet Assignments screen.
2. Select the Import button to bring up the context menu.

3. Select From LIMS > Watson LIMS.

(2] simple Plex Runner - v.34.0.48 - O X
File Settings Tools Help Demo Mode Enabled
New Kit H i T
o ssonnents | Inlet Assignments plgelElyisimple
Confirm Selections TFNg L-xa 53 TNF-s
Running Assay Inlet | Sample Type  Sample Name Diltion Factor KnownConc.  |KnownConc.  KnownConc.  knownConc.  Comments
Running Scan 1
Kit Results 2
H
4
s
s
7
]
9
0
1
2
5
1
5
5
From LIMS v Genericums
From Previous Kit Results File ‘ Watson LIMS ...
[ impen wﬂ;i“: | sdectml |[scecttione | [(coy | [d1Pae | | Reveme | [XCewr | |og> e D Undo | | Redo @
Cartridge C [
Assign Inlets and proceed to next step .
Current User: FW | kit 1a: 1000 4

Figure C-1: Edit Inlet Assignments with Import button selected.

This brings up the Import dialog:
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Import from Watson LIMS X
Select Sequence Files: [ Browse Al
IFNg [C:\Work\Test\1.5EQ | D Bowse |

IL2rm [C:\Work\Test\2.5EQ | D Bowse |

IL6 [C\Work'\Test\3.5EQ | D Bowse |

TNFa [CoWork'\Test\d.SEQ | D Bowse |

mpot | | Cancel |

Figure C-2: Import from Watson LIMS dialog.

4. Use the Browse buttons to specify the Sequence file for each analyte and then select the Import but-
ton. If you have existing information in your inlet assignments you will be prompted to overwrite it.

5. When the import is complete, the sample names and dilution factors will update, and the cartridge
comments will list the associated Watson run numbers.

134 simple Plex Runner - v.3.4.0.48 - [m] X
File Seftings Teols Help Demo Mode Enabled
New Kit i H H
[Inlet Assianments | Inlet ASSIgnmentS pI’Otem
Confirm Selections 1FNg Lza 16 N2
Running Assay Tnlet | Sample Type  Sample Name Dilution Factor Known Conc.  |KnownConc.  KnownConc.  KnewnConc.  Comments
Running Scan 1|Unknown  TestSample A 2
Kit Results 2| Unknawn TestHQC. 1 2
3
4
5
8
7
s
o
10
1
2
5
14
15
16
o dions: | Sl Al |[SceciNone | [ Copy | [f1Pase | [ Reveme | (K Oewr | | B ienced Redo €
Cartridge Cx |Walson run numbers 1,2, 3, 4
Assign Inlets and proceed to nexi step ..
Current User: FW/ | kit 1 1000 "

Figure C-3: Inlet Assignments with updated sample names and dilution factors.
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NOTE: Standards are ignored during the import. QCs are imported with a Sample Type of Unknown.

Exporting Run Data into Watson LIMS Sequence Files from Simple
Plex Software

Once the kit run is complete, the Sequence files can be updated with RFU data in either Simple Plex Runner
or Simple Plex Explorer.

1. Go to the Kit Results screen.
2. Select the Export button to bring up the context menu.

3. Select To LIMS - Watson LIMS.

15§ simple Plex Runner - v.3.4.0.48 - [m] X
File Setings Tools Help Demo Mode Enabled
e Sl
. imple
preN—— Kit Results prote pl
- - View
Confirm Seleclions | it 1d: 1000 - Cartridge Id: 20357
Running Assay @ Results Summary
Running Scan Analytes: IFNg, IL-2ra, IL-6, TNF-a O Inlet Assignments
O Watson run 12,34 O Gt
FNg (no LOQ) 1L-2ra (no LOQ) 116 (no LOQ) TNF-a (no LOQ)
Inlet  Sample GNRs | Mean RFU... Mean Conc. Conc. GNRs Mean ... RFU Mean Conc.... Conc.... GNRs Mean RFU... Mean Conc. Conc. GNRs Mean ... RFU Mean Conc.... Conc. ...
3 1 TestSample A 3 v 7215 042 438 0.43 3 v 1305 0.85 130 0.85 3 v 2140 143 135 149 3 v 1289 120 101 12%
2 TestHQC.1 3 v 8L18 045 462 0.46 3 v 1280 148 128 148 3 v 2165 1.50 137 1.56 3 v 1248 165 97.4 174
3 3 ~ 745 118 3 v 1264 035 3 v 2266 192 3 v 1247 230
4 5 v s 0 3 v 28 o 3 v 2a 154 3 v e 1w
5 3 v 7427 320 3 v 1215 3.88 3 v 2104 047 3 v 1260 0.83
s 3 v e 100 3 v 234 275 3 v ma 03 3 v 264 130
7 3 v 7732 1.04 3 v 13.03 153 3 v 2193 139 3 v 1294 204
8 35 v ma 0s 3 v e 205 3 v e 3w 3 v e 12
9 3 v 773 153 3 v 1271 04 3 v 208 015 3 v 1292 122
10 5 v mm 0m 3 v 1 5 v am 1w 3 v 22 05
11 3 v 747 1.2 3 v 1252 062 3 v 2124 081 3 v 13 194
I 3 v w3 081 3 v 2% o 35 vy ss 3 v s o4
13 3 v 73 064 3 v 1230 103 3 v 2125 0% 3 v 157 5.65
1 3 v s 101 3 v o231 25 3 v me 3m 3 v s 060
15 3 v 708 080 3 v 124 291 3 v 2093 143 3 v 17
15 3 v 7es 087 3 v 1225 10 3 v 23 oSt 3 v um o9t
4 G LIM: ‘ To LIMS
~WatsonliMS || «  To Clipboard
« ToPDFFile
Fiter GNFs By: | RFUCV. | Threshold (2 CVy 100 |3 | Addtional Options I Expott B
Save GNR Selection Changes Kitresults saved to Ki001000(51) cydat in CAUsers exKiiResulls m
Cumrent User: FW. | it 1d: 1000

Figure C-4: Kit Results Panel with Export button selected.

This brings up the Export dialog:
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Export to Watson LIMS *
Select Sequence Files: [ Browse Al
IFNg [C:\Work\Test\1.5EQ | D Browse

IL2rm [C:\Work\Test\2.5EQ | D Browse

IL6 [C\Work'\Test\3.5EQ | D Browse

TNFa [CoWork'\Test\d.SEQ | D Browse

Factory Standard Curve Data:

IFNg Curve ID: 1009 IL-2ra Curve ID: 1010 IL6 | CurveID: 1011 TNFa Curve ID: 1012
Export Cancel

Figure C-5: Export to Watson LIMS dialog.

4. The Sequence files will automatically populate with the selections used during the import if the applica-
tion has not since been closed. If it has, just use the Browse buttons to specify a different Sequence file
for each analyte.

5. Data from the factory calibration curves will automatically be retrieved if an internet connection is avail-
able. If not, you'll need to scan the curve barcodes from your COA.
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Export to Watson LIMS *
Select Sequence Files: [ Browse Al
IFNg [C:\Work\Test\1.5EQ | D Browse

IL2rm [C:\Work\Test\2.5EQ | D Browse

IL6 [C\Work'\Test\3.5EQ | D Browse

TNFa [CoWork'\Test\d.SEQ | D Browse

Factory Standard Curve Data:

Export Cancel

Figure C-6: Export to Watson LIMS dialog requiring curve barcode scanning.

6. Once the Sequence files have been specified and the Factory Standards data retrieved or scanned,
select the Export button to update the files with RFU data. The following dialog displays if the export is
successful.

Export to Watson LIMS

:l Export completed successfully.

Figure C-7: Export successful confirmation.

7. Once the export is complete, Watson LIMS can then be used to import the updated Sequence files.
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Overview

The followings steps show how to use the Generic LIMS Import and Export capability in Simple Plex Runner
and Explorer. This process uses CSV files to import and export data. The LIMS will need to be configured to
be able to load from and save to this type of file with specific column headers and data.

Steps from Simple Plex Runner

1.

If importing sample information into Simple Plex Runner, configure this in your LIMS and save to a prop-
erly formatted CSV file. See “Supported Columns List and File Specifications” on page 121 for format
specifications.

Tip: To get a sample CSV file, perform a generic LIMS export using any existing Kit Results file. In the
Summary Panel in Explorer, click the Export button and select To LIMS-Generic LIMS-Save CSV File
with Default Columns.

2. Open Runner Application Settings and enable automatic export of CSV file in the Generic LIMS sec-
tion using the setting AutoExportKitResultsToGenericLIMSFile.
NOTE: Automatic export is not required. A Generic LIMS export can be performed manually at any time
from Simple Plex Explorer or at the end of the run in Simple Plex Runner.

3. From the New Kit panel, scan the kit barcode. If using automatic export, confirm or change the Generic

LIMS Export File Name. Select Next to proceed to Inlet Assignments panel.

User Guide for Ella



Steps from Simple Plex Runner

page 116

144 Simple Plex Runner - v3.5.2.10

File Settings Tools Help

- o X
Demo Mode Enabled
e New kit ... poeng
Inet Assignments . AALMALL plge]esllplsimple

Confirm Selections
Running Assay

Running Scan 1) Scan Kit Barcode

2) Scan Cartridge Barcode

Current User: Fred

Figure D-1: New Kit panel.

Kit Results it 1D [1000 | [ D e o ‘.@ RDsrsres
Lot Number 1061
Expiration Date 05/08/2021 .
SAMPLE
0
e i
IL-2ra
IL6 T —
TNF-a *
——
ST [

.
SAMPLE

R LN T U TS S TR T
.

Cartridge ID 20357

BUFFER (1mL)

3) Confirm or Change Output File Names

Kit Results File Name ‘C \Users\Public\Ds

Generic LIMS Export File Name ‘C.\Users\PuDl\c\[‘

imple PlexiKitR 001000(14).cydat | |z Change | | Deau |
ple PlexiKitR 001000(4).cs¥ | |z crange

New Kit. Confirm the 'Kit Results File Name' before proceeding to the next step

4. From the Inlet Assignments panel, sample information can be imported from a Generic LIMS CSV file.
Click the Import button and select From LIMS-Generic LIMS.... Choose the appropriate CSV file in the
open file dialog. See “Supported Columns List and File Specifications” on page 121 for format specifica-

tions.

NOTE: Importing is not required.

An example of a CSV file used for importing is shown in Figure D-2. Column headers must match to be
properly imported. The only required columns are Inlet and Analyte Name.
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Figure D-2: Example CSV import file.

Appendix D: Generic LIMS Interface Guide

Inlet Sample Type Sample Name Dilution Factor Analyte Name Comments

A B

1 Unknown Test
1 Unknown Test
1 Unknown Test
1Unknown  Test
2 Unknown Test
2 Unknown Test
2 Unknown Test
2 Unknown Test
3 Unknown Test
3 Unknown  Test
3 Unknown Test
3 Unknown Test
4 Unknown Test
4 Unknown Test
4 Unknown Test
4 Unknown  Test
5 Unknown Test
5 Unknown Test
5 Unknown Test
5 Unknown Test
6 Unknown Test
6 Unknown  Test
6 Unknown Test
6 Unknown Test
7 Unknown Test
7 Unknown Test
7 Unknown Test
7 Unknown  Test
8 Unknown Test
8 Unknown Test
8 Unknown Test
wwn Tact
Kit001000

5. Run the cartridge as usual.

2 IFNg
21L-2ra
2/IL-6
2 TNF-a
2 IFNg
21L-2ra
2/1L-6
2 TNF-a
2 IFNg
21L-2ra
2/IL-6
2 TNF-a
2 IFNg
21L-2ra
2/IL-6
2 TNF-a
2 IFNg
21L-2ra
2/1L-6
2 TNF-a
2 IFNg
21L-2ra
2/IL-6
2 TNF-a
2 IFNg
21L-2ra
2/IL-6
2 TNF-a
2 IFNg
21L-2ra
2/1L-6
THE

6. When the run is complete, if the auto export was enabled then a Generic LIMS Export File (CSV) will be
produced in addition to the Kit Results File (CYDAT). Otherwise, click the Export button and select To
LIMS-Generic LIMS-Save CSV File with Default Columns' or To LIMS-Generic LIMS-Save CSV File

with Same Columns as Import.

NOTE: LIMS-Generic LIMS-Save CSV File with Same Columns as Import will be disabled if an import was

not performed.
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154 simple PlecRunner - v.3.4.0.48 - o x
File Settings Tools Help Demo Mode Enabled
New Kit ; [(elEllgisimple
Inlet Assignments Klt ReSUItS p
; _ View
Confim Selections 5t - 1000 - Cartridge I1d: 20357
Running Assay ® Resuits Summary
Running Scan Analytes: IFNg, IL-2ra, IL-6, TNF-a O Inlet Assignmerts
Comments: Q Calibration Curves
IFNg {ne LOQ) 1L-2ra (e LOQ) 1L-6 (no LOQ) TNF-a {ne LOQ)
Inlet | Sample GNRs | Mean ... RFU... | MeanConc.... Conc.... GNRs | Mean...|RFU... MeanConc..|Conc. ... |GNRs Mean... RFU... MeanConc....|Conc.... GNRS Mean..|RFU... MeanConc..| Conc..
»1Test 3 - 7.5 0e2 4 043 3 v 1305 085 130 085 3 v 24 14 135 19 3 v 1289 12 101 12
2 Test 3 sl 045 462 046 3 v Re0 L® 128 149 3 v o2ues L% 137 1% 3 v 124 165 974 174
3 Test 3 - 7645 L8 434 10 3 v 1264 035 126 035 3 v 26 192 143 199 3 v 247 250 973 263
4 Test 3 - 73 oas as1 0w 3 v 285 0.2 128 03 3 -2 L3 135 180 3 v ;4 142 974 150
5 Test 3 - 7827 am an 325 2 v 215 38 121 389 3 v 204 047 133 048 3 v Le0 083 984 0.87
6 Test 3 - 787 L0 437 02 3 v @3 275 123 275 3 - 24 025 141 025 3 v 1264 13 987 1%
7 Test 3 - 77232 104 439 105 3 v 1303 153 130 153 3 - 2103 L3 138 144 3 v 1204 204 101 215
& Test 3 - 74 0 a5t 046 3 v 291 205 129 205 3 - 243 3w 135 321 3 v Be0 L2 107 127
o Test 3 - 7731 15 43 155 3 v 1271 045 127 045 3 v 083 015 13 0.5 3 v 22 12 101 1
10 Test 3 - 71 0 450 028 3 v 7L 1% 127 146 3 v oum Lm 137 185 3 v 1221 055 951 0.5
11 Test 3 - 7% 12 4 1 3 v 125 06 125 06 3 v 224 o081 134 084 3 v 23 194 960 205
12 Test 3 - % 081 445 082 3 v 2% 04 123 0o# 3 - w1 551 127 571 3 v 1% 04 934 051
13 Test 3 - 763 064 43 065 3 v 23 103 123 103 3 - 2125 0% 138 088 3 v 1157 565 899 595
14 Test 3 - 73 01 437 102 3 v 1231 254 123 25 3 - 063 33 130 34 3 v 1195 060 930 063
15 Test 3 - 7606 080 43 081 3 v 24 201 124 201 3 v w3 143 13 19 3 v 1217 17 48 188
16 Test 3 - 7383 087 420 085 3 v 225 10 122 w0 3 v o3 05 134 05 3 v 17 081 817 0.9
l Save CSV File with Default Columns ||« GenerieLivs || « 1oULS
‘ Save CSV File with Same Columns as Import ‘Watson LIMS 4 ToClipboard
4 ToPDFFile
Fiter GNRs By: | RFUCV | Threshold (z.CV) (100 |2 |~ Additional Options Export -
Save GNR Selection Changes Kit results saved 1o Kit01000(G: LIMs) cvdatin C:\Users i xKitResults m
Current User: FW | Kit 1d: 1000

Figure D-3: Kit Results.

The Generic LIMS export has two options to determine which columns are included in the export.
Select Default Columns to use the fixed format specified by the software. Select Same Columns as
Import to use the same columns used in the CSV file specified during the import. For this second
option, any additional user specified columns will be preserved with its data. See “Supported Columns
List and File Specifications” on page 121 for more information.

7. Use the Windows File Browser to view the exported CSV file. The Default Columns option is shown in
Figure D-4.
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A B C D E F G H 1 J K L M N o P Q R |~

1 Kitld Inlet Sample Type Sample Name Dilution Factor Analyte Name Known Conc. Capture Name Capture Conc. Detect Name Detect Conc. GNRs Mean RFU RFU %CV Mean Conc. Conc. %CV Comments
2 | 1000 1 Unknown Test 2 IFNg 3 77.15 0.42 438|

3 | 1000 1 Unknown Test 2 IL-2ra 3 13.05 0.85 130

4 | 1000 1 Unknown Test 21L-6 3 214 143 135

5 | 1000 1 Unknown Test 2 TNF-a 3 12.89 12 101

6 | 1000 2 Unknown Test 2 IFNg 3 81.19 0.45 462

7 | 1000 2 Unknown Test 2 IL-2ra 3 12.8 1.49 128

8 | 1000 2 Unknown Test 21L-6 3 21.65 15 137

9 | 1000 2 Unknown Test 2 TNF-a 3 12.48 1.65 97.4

10 | 1000 3 Unknown Test 2 IFNg 3 76.45 118 434

11| 1000 3 Unknown Test 2 IL-2ra 3 12.64 0.35 126

12 | 1000 3 Unknown Test 21L-6 3 22.66 1.92 143

13 | 1000 3 Unknown Test 2 TNF-a 3 12.47 25 97.3

14 | 1000 4 Unknown Test 2 IFNg 3 79.35 0.19 451

15 | 1000 4 Unknown Test 2 IL-2ra 3 12.85 0.28 128

16 | 1000 4 Unknown Test 21L-6 3 21.44 1.54 135

17 | 1000 4 Unknown Test 2 TNF-a 3 12.45 1.42 97.1

18 | 1000 5 Unknown Test 2 IFNg 3 74.27 32 422

19 | 1000 5 Unknown Test 2 IL-2ra 3 12.15 3.88 121

20 | 1000 5 Unknown Test 21L-6 3 21.04 0.47 133

21| 1000 5 Unknown Test 2 TNF-a 3 12.6 0.83 98.4

22 | 1000 6 Unknown Test 2 IFNg 3 76.87 1 437

23 | 1000 6 Unknown Test 2 IL-2ra 3 12.34 2.75 123

24 | 1000 6 Unknown Test 21L-6 3 224 0.25 141

25| 1000 6 Unknown Test 2 TNF-a 3 12.64 13 98.7

26 | 1000 7 Unknown Test 2 IFNg 3 77.32 1.04 439

27 | 1000 7 Unknown Test 2 IL-2ra 3 13.03 1.53 130

28 | 1000 7 Unknown Test 21L-6 3 21.93 1.39 138

29 | 1000 7 Unknown Test 2 TNF-a 3 12.94 2.04 101

30 | 1000 8 Unknown Test 2 IFNg 3 794 0.46 451

31| 1000 8 Unknown Test 2 IL-2ra 3 12.91 2.05 129

32 | 1000 8 Unknown Test 21L-6 3 21.43 31 135

33 | 1000 8 Unknown Test 2 TNF-a 3 13.6 1.21 107 .
2l labnown  Tast 1N 1 1 230 4 -

Kit001000(GenericLIMsExport) @ 1 v

Figure D-4: Exported CSV file.

8. Load the exported CSV file into your LIMS to get the RFU and Concentration data for the kit.

Steps from Simple Plex Explorer

To import a Generic LIMS CSV file in Simple Plex Explorer:

1. Edit the desired kit.

2. From the edit dialog, click the Import button in the lower left and select From LIMS-Generic LIMS ....
3. Choose the appropriate CSV file in the open file dialog.

See "Supported Columns List and File Specifications” on page 121 for additional details on importing.
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# Edit Samples for Kit 1000 O X
IFNg IL-2ra L5 TNF-3
Inlet | Sample Type | Sample Name Dilution Factor Known Canc. Known Conc. Known Conc. Known Canc. Comments
1
2
3
4
5
)
7
8
9
10
11
12
13
14
15
16
From LIMS v I GenericLms..
From Previous Kit Results File ... Watson LIMS ...
+  Impot Tﬂimz Select Al || Select None (7 Copy | &1 Paste Reverse X Clear oy g llndo | [Redo @
Cartridge Comments: | ‘
Apply Cancel

Figure D-5: Edit kit samples.

To export a Generic LIMS CSV file in Simple Plex Explorer:

1. Load the desired kit results file.

2. From the Results Summary panel, click the Export button and select To LIMS-Generic LIMS-Save CSV
File with Default Columns or To LIMS-Generic LIMS-Save CSV File with Same Columns as Import.

NOTE: To LIMS-Generic LIMS-Save CSV File with Same Columns as Import will be disabled if an import was
not performed. See “Supported Columns List and File Specifications” on page 121 for additional details on

exporting.
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(3 simple Plex Explorer - v.34.0.42 - [u] X

File View Tools Help

2
HIEL Anaites Encypted  Flename Fun Date User Specimen Typels) Species Type Lot Number | Sotected Kt
= 1000 IFNg. IL-Zra. IL-6. TNF-a No Clk ol 12/27/2018 2: W PlasmaSemum Human 1061 Save
2
= Save As
]
g Edit
3
Remave
Remove All
< > Export Kits
- . View
Kit Id: 1000 - Cartridge Id: 20357
@ Results Summary
Analytes: IFNg, IL-2ra, IL-6, TNF-a O Inlet Assignmerts
Comments: O Caloration Curves
TFNg (no LOQ) IL-2ra (o LOQ) L6 (no LOQ) THF-a (no LOQ)
Inlet  Sample GNRs  Mean ... RFU Mean Conc.... Conc.... GNRs Mean RFU Mean Conc. Conc. GNRs  Mean RFU Mean Conc. Conc. GNRs  Mean RFU ... Mean Conc. Conc.
» 1 Test 3 v 7115 0.92 219 0.43 3 v 13.05 0.85 65.0 0.85 3 v 2140 143 67.5 149 3 v 1289 L0 504 126
2 Test 3 v 8L19 0.45 231 0.496 3 v 1280 149 63.8 14 3 v 2165 150 683 156 3 v 1248 165 48.7 174
3 Test 3 v 76.45 118 217 120 3 v 1264 0.35 63.0 0.35 3 v 2286 192 716 199 3 v 1247 2.50 48.7 263
4 Test 3 v 79.35 0.18 226 0.20 3 v 1285 0.28 64.0 0.28 3 v 2144 1.54 67.6 1.60 3 v 1245 142 48.6 1.50
5 Test 3 v 7427 3.20 211 3.25 3 v 15 3.88 60.5 3.89 3 v 2104 0.47 66.3 0.48 3 v 1280 0.83 49.2 0.87
6 Test 3 v 76.87 1.00 218 102 3 v 1234 275 615 2.75 3 v 24 0.25 70.7 0.26 3 v 1264 L30 493 136
7 Test 3 v 77.32 1.04 220 105 3 v 13.03 1.53 64.9 153 3 v 2193 139 69.2 14 3 v 1294 204 50.6 2.15
8 Test 3 v 79.40 0.46 226 0.46 3 v 1281 2.05 643 2.05 3 v 2143 3.10 67.6 3.21 3w 1360 121 533 127
9 Test 3 v 7731 153 220 156 3 v rn 0.45 63.3 0.45 3 v 2093 0.15 65.9 0.15 3 v 1292 L2z 50.5 128
10 Test 3 v P19 0.28 225 0.29 3 v rA 146 63.3 L% 3 v 217 178 68.7 185 3 v 1221 0.55 47.6 0.58
11 Test 3 v A% 128 212 130 3 v 1252 0.62 624 0.62 3 v 2124 0.81 67.0 0.84 3 v 1231 154 48.0 2.05
12 Test 3 v 7836 0.81 223 0.82 3 v 1236 0.44 61.6 0.44 3 o+ 20.17 5.51 635 5.71 3w 1196 0.48 46.5 0.51
13 Test 3 v 7636 0.64 217 0.65 3 v 3 103 613 103 3 v 2125 0.96 67.0 0.99 3 v 1L57 5.65 44.9 5.95
14 Test 3 v 79 101 219 102 3 v 1231 258 613 254 3 v 206 I T e = Generic LIMS a ToLIMS.
15 Test 3 v 76.06 0.80 216 0.81 3 v 1240 291 618 291 3 ~ 2093
v v < as 4 ToClipboard
16 Test 3 v 7389 0.87 210 0.89 3 v 1235 1.00 61.0 1.00 3 v 231 ‘ Save CSV File with Same Columns as Import | . Watsen LIMS o Clipboar
< To PDF File
Fiter GNRs By: | RFUCV ~ Threshold (%.CV) 100 5 “ Additional Options Export B

| 1 Kits Loaded | No Curves Loaded

Figure D-6: Results Summary panel.

Supported Columns List and File Specifications

Exact Column Is Default

Name Required Importable Column Additional Details

Kit Id Yes

Inlet Yes Yes Inlet number.

Sample Type Yes Yes Possible values are Unknown, Stan-
dard, Control, or Spike.

Dilution Factor Yes Yes

Analyte Name Yes* Yes* Yes Field is required for all cartridge
types except 48x1. Importable for
48x1 only.

Known Conc. Yes Yes
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Exact Column Is Default

Name Required Importable Column Additional Details

Capture Name Yes* Yes Importable for 48x1 only.
Capture Conc. Yes* Yes Importable for 48x1 only.
Detect Name Yes* Yes Importable for 48x1 only.
Detect Conc. Yes* Yes Importable for 48x1 only.
GNRs Yes The number of selected GNRs.
Mean RFU Yes The mean of selected GNRs.
RFU %CV Yes

Mean Conc. Yes The mean of selected GNRs.
Conc. %CV Yes

Comments Yes Yes Inlet comments.

Units Yes* Yes Importable for 48x1 only.

*Indicates there are exceptions based on cartridge format. See Additional Details column.

Table D-1: Columns and specifications.

Additional Specifications

Columns names must match table.
Columns can be specified in any order for importing.

Rows can be specified in any order for importing, but export will be ordered by inlet then analyte
name.

Columns that are not importable and in the table will be ignored during import. For the Same Col-
umns as Import export option, these columns will be filled with the appropriate data during the
export.

Columns that are not in this table will be ignored during import. For the Same Columns as Import
export option, these columns will be reproduced with data.

Tip: This can be used to provide and preserve additional metadata from the LIMS.

The columns in the Default Columns export option are those marked as Is Default Column. Column
order will match the row order in this table.
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Custom Column Import and Export Example Files

The examples below show the import of a CSV file with a custom column and export using the Same Col-
umns as Import option.

Import File: The first column here is a custom column.

1
2
3
4
5
6
7
8
L}

10
1
12
13
14
15
16
17

19

A
LIMs Id

Analyte Name Inlet Sample Type Sample Name Dilution Factor GNRs Mean RFU Mean Conc. Kitld

B C D

3 IFNg 1 Unknown
3 IL-2ra 1 Unknown
3IL-6 1 Unknown
3 TNF-a 1 Unknown
3 IFNg 2 Unknown
3/IL-2ra 2 Unknown
3IL-6 2 Unknown
3 TNF-a 2 Unknown
3 IFNg 3 Unknown
3IL-2ra 3 Unknown
3IL-6 3 Unknown
3 TNF-a 3 Unknown
3 IFNg 4 Unknown
3 IL-2ra 4 Unknown
3IL-6 4 Unknown
3 TNF-a 4 Unknown
3 IFNg 5 Unknown
3/IL-2ra 5 Unknown
3IL-6 5 Unknown
3 TNF-a 5 Unknown
3 IFNg 6 Unknown
3IL-2ra 6 Unknown
3IL-6 6 Unknown
3 TNF-a 6 Unknown
3 IFNg 7 Unknown
3 IL-2ra 7 Unknown
3IL-6 7 Unknown
3 TNF-a 7 Unknown
3 IFNg 8 Unknown
3/IL-2ra 8 Unknown
3IL-6 8 Unknown
3 TNF-a 8 Unknown
3 IFNg 9 Unknown
3IL-2ra 9 Unknown
3-6

LimsRun0003

Figure D-7: Example import file.
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Export File: The first column here was preserved by export. GNRs, Mean RFU, Mean Conc. and Kit Id col-

umns were filled.

Figure D-8: Example export file.
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A

3

B C D E F G H | J
LIMs Id Analyte Name Inlet Sample Type Sample Name Dilution Factor GNRs Mean RFU Mean Conc. Kit Id
IFNg 1 Unknown Test 2 3 77.15 438 1000
IL-2ra 1 Unknown Test 2 3 13.05 130 1000
IL-6 1 Unknown Test 2 3 21.4 135 1000
TNF-a 1 Unknown Test 2 3 12.89 101 1000
IFNg 2 Unknown Test 2 3 81.19 462 1000
IL-2ra 2 Unknown Test 2 3 128 128 1000
IL-6 2 Unknown Test 2 3 21.65 137 1000
TNF-a 2 Unknown Test 2 3 12.48 97.4 1000
IFNg 3 Unknown Test 2 3 76.43 434 1000
IL-2ra 3 Unknown Test 2 3 12.64 126 1000
IL-6 3 Unknown Test 2 3 22.66 143 1000
TNF-a 3 Unknown Test 2 3 12.47 97.3 1000
IFNg 4 Unknown Test 2 3 79.35 451 1000
IL-2ra 4 Unknown Test 2 3 12.85 128 1000
IL-6 4 Unknown Test 2 3 21.44 135 1000
TNF-a 4 Unknown Test 2 3 12.45 97.1 1000
IFNg 5 Unknown Test 2 3 74.27 422 1000
IL-2ra 5 Unknown Test 2 3 12.15 121 1000
IL-6 5 Unknown Test 2 3 21.04 133 1000
TNF-a 5 Unknown Test 2 3 126 98.4 1000
IFNg 6 Unknown Test 2 3 76.87 437 1000
IL-2ra 6 Unknown Test 2 3 12.34 123 1000
IL.-6 6 Unknown Test 2 3 224 141 1000
TNF-a 6 Unknown Test 2 3 12.64 98.7 1000
IFNg 7 Unknown Test 2 3 77.32 439 1000
IL-2ra 7 Unknown Test 2 3 13.03 130 1000
IL-6 7 Unknown Test 2 3 21.93 138 1000
TNF-a 7 Unknown Test 2 3 12.94 101 1000
IFNg 8 Unknown Test 2 3 79.4 451 1000
IL-2ra 8 Unknown Test 2 3 12.91 129 1000
IL-6 & Unknown Test 2 3 21.43 135 1000
TNF-a & Unknown Test 2 3 13.6 107 1000
IFNg 9 Unknown Test 2 3 77.31 433 1000
IL-2ra 9 Unknown Test 2 3 1271 127 1000
15 alinknnwn __ Test 2 a 2093 1321000

3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
3
E)

it001000(LimsRun0003)
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